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1.1 Introduction

Thank you for choosing Hioki's Partial Discharge Detector ST4200. Preserve this manual carefully and keep it
handy to make full use of this instrument for a long time.

The latest edition of the instruction manual
The contents of this manual are subject to change, for example as a result of product
improvements or changes to specifications.
The latest edition can be downloaded from Hioki's website.
https://www.hioki.com/global/support/download/

Product registration
Register your product in order to receive important product information.
https://www.hioki.com/global/support/myhioki/registration/

Read the following Operating Precautions carefully before using the instrument.
Refer to the instruction manuals below as relevant to your purpose.

Type Contents Format

Operating
Precautions

This provides information on the instrument for safe operation. Print

Startup Guide
This guide contains information on how to safely use the
instrument, basic operating instructions, and specifications
(excerpt).

Print

ST4200 Instruction
Manual (this
document)

This manual contains an product overview, operating instructions,
function descriptions, and specifications.
https://manual.hioki.com/en/ST4200-50/manual

HTML

SW2001
Instruction Manual

This manual contains an SW2001 product overview, operating
instructions, function descriptions, and specifications.
https://manual.hioki.com/en/SW2001/manual

HTML

Introduction1
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Type Contents Format

ST9210 Instruction
Manual

This manual contains a product overview, operating instructions,
function descriptions, and specifications of the ST9210.
Download this manual from Hioki’s website.
https://www.hioki.com/global/support/download/

PDF

Target audience

This manual has been written for use by individuals who use the product in question or who teach others to
do so. It is assumed that the reader possesses basic electrical knowledge (equivalent to that of someone
who graduated from an electrical program at a technical high school).

Trademarks

Windows is a corporate trademark of the Microsoft Group.
The SD logo is a trademark of SD-3C, LLC.
Other product names and company names are trade names, registered trademarks or trademarks of the
respective companies.
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1.2 Confirming Package Contents

When the instrument arrives, inspect it carefully to ensure that everything is in good condition and there is no
damage.
If the instrument seems to have been damaged or does not work as specified, contact your authorized Hioki
distributor or reseller.
Confirm that the package contents are correct.

Instrument

☐ Partial Discharge Detector ST4200-50

Included accessories

☐ Power cord

☐ Operating Precautions (0990A905)

☐ Startup Guide
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1.3 Options (Sold Separately)

The following options are available for the instrument. Use the product available as Hioki’s option only. To
buy, contact your authorized Hioki distributor or reseller.
The options are subject to change without prior notice. Visit our website (https://www.hioki.com) for updated
information.

High voltage multiplexer with PD sensor (Option available only when ordered
with the instrument)

Specify one of two types of PD sensors when ordering.

External storage devices (Option available only when ordered with the
instrument)

External storage devices

Communication cables

PD sensor

High Voltage Multiplexer SW2001-04 (4 channels)
High Voltage Multiplexer SW2001-08 (8 channels)
High Voltage Multiplexer SW2001-16 (16 channels)
High Voltage Multiplexer SW2001-24 (24 channels)

SSD Unit U8332

SD Memory Card Z4001 (2 GB)
SD Memory Card Z4003 (8 GB)
USB Drive Z4006 (16 GB)

RS-232C Cable L9637
USB Cable (A-B) L1002

PD Sensor ST9210
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1.4 Notations

Safety notations

In this document, risk levels are classified as follows.

Notation Description

Indicates an imminently hazardous situation that, if not avoided, will result in
death or serious injury.

Indicates a potentially hazardous situation that, if not avoided, could result in
death or serious injury.

Indicates a potentially hazardous situation that, if not avoided, could result in
minor or moderate injury or potential risks of damage to the supported product
(or to other property).

Indicates information or content particularly important from the standpoint of
operating or maintaining the product.

Indicates a high-voltage hazard.
Failure to verify safety or improper handling of the product could lead to an
electric shock, a burn, an injury, or a death.

Indicates a prohibited action.

Indicates a mandatory action.

Symbols affixed to the instrument

Notation Description

Indicates the presence of a potential hazard. See the "Operation Precautions" and
safety notes listed at the beginning of operating instructions in the instruction
manual(s), and the accompanying document entitled Operating Precautions.

Indicates the push-button switch that can turn the product on and off.

8HIOKI ST4200B971-00



Notation Description

Indicates an earthing terminal.

Symbols for Standards

Notation Description

Indicates that the product is subject to the Directive on Waste Electrical and Electronic
Equipment (WEEE) in EU member nations. Dispose of the product in accordance with
local regulations.

Indicates that the product complies with standards imposed by EU directives.

Indicates that the product complies with Korean regulations.
Declarer: HIOKI KOREA CO., LTD.
http://www.rra.go.kr/selform/HKO-ST4200-50

Notation of terms for partial discharge

Notation Description

PD Abbreviation for “partial discharge.”

AC PD
Indicates the partial discharge generated when high voltage is applied to the object
under measurement.
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Other notations

Notation Description

Settings button

Indicates the settings button at the top left of the screen.

Flash drive eject
button

Indicates the flash drive eject button at the bottom right of the screen.

Indicates useful functions and advice you should know.

* Indicates that additional information is described below.

See: (Title) Takes you to a reference page.

START
(Boldface)

Indicates on-screen names and keys.

[ ] On-screen user interface names are displayed in brackets ([ ]).

Windows
Unless otherwise noted, the term “Windows” is used generically to refer to
Windows 7, Windows 8, Windows 10, and Windows 11.

pcs Unit representing pieces.

pps Unit representing pulses per second.
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Notation Description

div Unit representing one division on the temporal axis of a graph.

S/s

Unit representing samples per second (S/s), the number of times per second
the analog input signals are digitized by the instrument.
Example: "20 MS/s" indicates that the signal is digitized 20 × 10  times per
second.

6
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1.5 Safety Information

The instrument is designed in accordance with the IEC 61010 international standard and their safety was
confirmed during pre-shipment inspections.
However, using the instrument in a way not described in this manual may diminish their safety.
Read the following safety notes carefully before using the instrument.

DANGER
Mishandling the instrument could result in bodily injury or even death, as well as damage to the
instrument. Familiarize yourself with the instructions and precautions in this manual before using
the instrument.

WARNING
Electricity can cause potentially serious events such as an electric shock, heat generation, fire,
and an arc flash due to a short-circuit. If you have not used electrical measuring instruments
before, you should be supervised by a technician who has experience in electrical
measurement.

Protective gear

WARNING
The PD test performed using this instrument is measured on a live line. To prevent an electric
shock, use appropriate protective insulation and adhere to applicable laws and regulations.
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1.6 Operation Precautions

Follow these precautions to ensure safe operation of the instrument and to obtain the full benefits of its
various functions.
Ensure that your use of the instrument falls within the specifications not only of the instrument itself, but also
of any included accessories and options being used.

Installing the instrument

WARNING
Installing the instrument in inappropriate locations could cause a malfunction of the instrument
or an accident. Avoid locations that are:

Unplugging the power cord kills power to the instrument. Be sure to provide enough
unobstructed space to unplug the power cord immediately in an emergency.

Exposed to direct sunlight or high temperatures
Exposed to corrosive or combustible gases
Exposed to strong electromagnetic fields or electrostatic charges
Near induction heating systems (such as high-frequency induction heating systems and IH
cooking equipment)
Susceptible to vibration
Exposed to water, oil, chemicals, or solvents
Exposed to high humidity or condensation
Exposed to high quantities of dust particles
On top of unstable platforms or inclined surfaces

Do not stack multiple instruments.
Place the instrument with the bottom or rear side downwards.
Leave at least 5 cm (2 inches) of space on every surface other than the underside to ensure that the air vents
are not obstructed to keep the instrument’s temperature from rising.
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Handling the instrument

WARNING
The input terminals on this instrument are used only for signal inputs from the High Voltage
Multiplexer SW2001 or the PD Sensor ST9210. Do not use inputs from devices or sensors other
than the SW2001 and the ST9210. Damage to the instrument or overheating can cause bodily
injury.

The instrument is an EN 61326 Class A product. When using in a home environment such as a residential
area, it may interfere with the reception of radio and television broadcasts. In such cases, workers should
implement appropriate measures.
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Before connecting the instrument to external equipment

CAUTION

Precautions during measurement

DANGER

Precautions during shipment

Store the packaging materials after unpacking. Use the packaging materials that came with instrument when
transporting it.

CAUTION
To avoid damage to the instrument, protect it from physical shock when transporting and
handling. Be especially careful to avoid physical shock due to dropping it.

Connect the ground terminal of the instrument and the ground terminal of connected equipment
to a single grounding point with sufficiently low impedance. Using different ground circuits will
result in a ground potential difference between the instrument and the connected equipment. If a
cable is connected while such a potential difference between grounds exists, it may result in
equipment malfunction or failure.
Before connecting or disconnecting any cable, always turn off the instrument and your device to
be connected. Failure to do so could result in an equipment malfunction or damage to the
equipment.
To prevent damage to the equipment, use the recommended type of wires to connect your
external equipment to the external control terminals, or otherwise ensure that the wires have
sufficient withstand voltage and current capacity.

Do not use the instrument to measure circuits that exceed those ratings or specifications.
Damage to the instrument or overheating can cause bodily injury.
Connect the functional ground terminal to the ground if subject to the impact of noise.
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2.1 Product Overview

This Partial Discharge Detector is equipped with the functionality to perform both AC PD measurements in
conformance with IEC 60270 (2015) and IEC 60034-27-1 (2017).

Overview2
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2.2 Features

Noise resistance performance that withstands noise when used on a
production line

Generally, a PD detector is sensitive to noise, which makes measurement in a noisy environment such as a
production line difficult. This instrument realizes high noise resistance performance that can withstand noise
when used on a production line due to its sensor part (option) and detection and calculation parts that are
insusceptible to noise.

Measurement conforms to IEC standards

Measurements that conform to PD-related IEC standards and for which interpretation and measurement is
complex are simple to perform with this instrument.

Provides analysis for both production line testing and research and
development

The instrument is equipped with a simple screen mode (function) suitable for use on a production line. The
measurement system used at the research and development stage can be applied as is to production lines.
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2.3 Name and Function of Each Part

Overall appearance
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No. Name Function Reference

1 Media box

Holds the SSD unit.
One port is available for USB 3.0 connector
(dedicated to USB flash drives). Always use the
instrument with the cover closed.

How to Open
the Media Box

2 Handle The handle used to carry the instrument. -

3 Air vents
These holes provide ventilation to prevent the internal
temperature of the instrument from increasing to a
high temperature.

Installing the
instrument

4 USB connector
Connect a USB flash drive, USB mouse, or USB
keyboard.

USB flash drive

5 Display
A 12.1-inch TFT color LCD equipped with a capacitive
touch panel.

-

6 Feet
These feet are used to incline the instrument for better
visibility of the screen. These feet are used for easier
operation of the touch panel.

-

7 Serial number

For the latest information, check Hioki's website. This
label is needed for administrative purposes. Do not
remove this label. Inform your authorized Hioki
distributor or reseller of this number if required.

-

8
GND terminal
(Functional earth
terminal)

Ground this terminal.
Supplying
Power to the
Instrument

9 Power inlet Connects the power cord provided.
Supplying
Power to the
Instrument
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SAVE key

No. Name Function Reference

10 SAVE key
Opens the manual saving dialog box.
Lights up in blue while accessing the storage
device.

-

11
Shortcut
keys

Frequently-used settings can be registered on
the keys.

Shortcut keys

12
VALUE
rotary knob

Changes the setting value for the slider bar. VALUE

13
SCREEN
rotary knob

Transitions the displayed screen. SCREEN

14 START key
Starts measurement. Lights up in green during
a measurement.

-

15 STOP key Stops the measurement. -

16 Power key Used to turn the instrument on and off.
Supplying Power to the
Instrument
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Right side

No. Name Function Reference

1 USB connector
Connect a USB flash drive, USB mouse, or
USB keyboard.

USB flash drive

2 SD memory card slot Insert an SD memory card. SD memory card

3 KEY LOCK
Disables the touch panel and key
operation.

Key lock

4
LAN connector
(100BASE-TX)

Plug a LAN cable to connect the
instrument to your network.

ACT LED
Blinking: Communicating data
LINK LED
Orange light: 100BASE
Off: 10BASE

Connecting the
Instrument With
Computers

5 DVI-I terminal Outputs the screen display. -

6
External control
terminals

Enables to control the instrument by
inputting external signals, or output signals
externally.

Connecting the
External Control
Terminals

7
Measurement signal
input terminal

Terminal used to input measurement
signals from the SW2001 or the ST9210.

Connecting
Connection Cables
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CAUTION
Do not use the terminals for which N/A is displayed. This may result in damage to the instrument
or connected equipment.
Do not connect any equipment other than the SW2001 or the ST9210 to the measurement signal
input terminal. This may result in damage to the instrument or connected equipment.
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2.4 Appearance Drawings

Front
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Right side
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Left side
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Rear

Top
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Bottom
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Handle
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2.5 Types of Measurement Modes

This instrument has the following two measurement modes.
Normal mode: This mode applies constant voltage to measure the magnitude of a partial discharge.
PDIV mode: This mode performs measurement while adjusting measurement voltage up and down to
measure partial discharge inception voltage (PDIV) and partial discharge extinction voltage (PDEV).
Each measurement mode has an AC PD measurement function.
The partial discharge value when performing an AC PD measurement will be displayed as Qmax (repeatedly
occurring maximum PD intensity).

Normal mode

This mode applies constant voltage to measure the magnitude of a partial discharge. Press the START key
to control the high-voltage power supply, apply voltage to the object under measurement, and begin
measuring. For single measurements, high-voltage output and the measurement operation will stop
automatically once measurement is complete. For repeat measurements (freely running), measurement will
continue until the STOP key is pressed.
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PDIV mode

This mode performs automatic PDIV and PDEV measurements in conformance with IEC standards. For AC
PD measurements, output voltages will be consecutively increased and decreased to measure PDIV and
PDEV.
PDIV: Partial Discharge Inception Voltage
PDEV: Partial Discharge Extinction Voltage
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2.6 Finding PDIV Mode Parameters

Finding PDIV and PDEV for AC PD measurement

The following graph shows the relationship between the applied voltage and maximum PD charge, and
Qmax, when AC PD is repeatedly measured while changing the applied voltage.
(Horizontal axis: Applied voltage, Vertical axis: Repeated PD pulse magnitude)

IEC 60034-27-1
PDIV value Ui is the voltage when the voltage increases and Qmax exceeds the set threshold value Qth
PDEV value Ue is the voltage when the voltage decreases and Qmax is lower than the set threshold value Qth
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2.7 Basic Operation

Touch panel

The touch panel allows the following operations.

Touch
operation

Operation
name

Description

Tap “Tap” means to touch the display and then to lift the finger quickly.

Drag
“Drag” means to select something shown on the display with a
finger by touching it and to slide the finger while toughing the
display.

Rotary knob

VALUE

While the slider bar setting screen is displayed, rotate the VALUE rotary knob to change by increments of
[100].
Press the rotary knob to change by increments of [10] when the knob is rotated. Press the knob again to
return the increment to [100].
When configuring using the slider bar, the VALUE LED rotary knob will light up in green and become enabled
for operation.

32HIOKI ST4200B971-00



SCREEN

Use the SCREEN rotary knob to change the [Measurement No.]. Every time this rotary knob is pressed, the
Measurement No. is set to the default value.
When [Measurement No.] is displayed on the measurement screen, the SCREEN rotary knob is lit in red
and its operation is enabled.
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Changing screens and settings

Switching the setting screens

Tap a tab to switch the setting screens.
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Selecting using a slider bar

This is used when setting integer values. The following three setting methods are available:

1. Tapping the six buttons to increase and decrease the value above the slider bar.
2. Moving the slider bar knob by dragging it.
3. Turning the VALUE rotary knob.

Example: When inputting a test voltage
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Inputting using a numeric keypad

This is used when setting values with decimal points. Select a value by tapping on the numerical keypad.
Example: When setting the upper limit current value
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Selecting an option from a list

Select an option by tapping on the drop-down list box.
Example: When selecting the measurement sensitivity
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Entering numerical values

Select a value by tapping on the up and down keys for each number.
Example: When selecting an IP address
See: Equipment Connection
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Touch keyboard

This is used for inputting the name of the folder and file to which the measured data is saved. Tapping an
input box allows you to enter characters with the touch keyboard. The touch keyboard can be used to enter
letters and numbers. Each time the square icon to the top right of the touch keyboard is tapped, the
keyboard switches between fixed and floating on the screen.
See: Setting Measurement Conditions and Judgment Conditions
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Icon Description

You can drag the keyboard.

You cannot drag the keyboard.

40HIOKI ST4200B971-00



Icon Description

Each tap switches the keyboard switches between fixed and floating on
the screen.

Closes the keyboard.
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Mouse operation

Using a commercially available USB mouse enables you to operate the instrument as with the touch panel.
Mouse operation for the instrument is as follows:

Mouse operation Touch operation Description

Click

Same action as tapping the
screen

Allows you to select a menu or execute an
action.

Center wheel

- Scrolls through data series and tables.

Up/down/left/right

- Moves the mouse cursor around.

External noise may cause the mouse to malfunction. Keep the mouse and mouse cable as far away as
possible from sources of noise.
Use the mouse on an insulated table. Some mouses commercially available are susceptible to
noise and using such a mouse on a metal table may cause the instrument to malfunction.
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Key lock

The key lock function disables touch panel operation and key operation to prevent an operation
error during measurement. Even if the key lock is engaged, the external control terminals and remote
operation are enabled. Slide the KEY LOCK switch until it clicks.

Depending on the key lock engaged, the following icons are displayed on the bottom right of the screen.

Icon Description

Displayed when the ALL key lock is engaged.

Displayed when the TOUCH PANEL key lock is engaged.
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Help function

Item Explanation Function

Tapping on a measurement parameter or setting parameter on the setting screen displays a balloon
explaining that parameter.
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Instruction Manual Display Function

Use this function to display an HTML file of the instruction manual.

1 Tap [Func] > [Help] > [Instruction Manual].
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File management

Open Explorer and use it to manage data saved to the media.

Explorer functions

Item Description

Change
Media

Changes the media.

Sort Sorts the files in the file list in the selected order.

Move to
Folder

Moves to the selected folder.

Copy
Copies the file to the specified folder. Or, if the selected item is a folder, it copies the
entire folder to the specified folder.

Create
Folder

Creates a new folder.

Rename Renames a file or folder.

Delete Deletes a file or folder.

Initialize Formats the selected media.
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Opening Explorer

1 Tap [Func] > [File Explorer].
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2.8 Measurement Procedure

The basic measurement procedure is as follows.

AC PD measurement

Preparing for measurement

See: Preparing for AC PD Measurement

Warming up and zero adjustment

1. Turn the instrument on and allow it to warm up for about 30 minutes. See: Supplying Power to the
Instrument

2. Execute zero-adjustment. See: Executing zero-adjustment

Band Pass Filter Settings

1. Power on the Hipot tester and check that the output is OFF.
2. Tap [AC PD] > [Band Pass Filter] to display the band pass filter setting screen.
3. Input the high cutoff frequency in [fH] and the low cutoff frequency in [fL].
4. Tap [OK] to close the band pass filter setting screen.

See: Configuring the Band Pass Filter

Charge calibration

1. Connect the calibration pulse generator to the object under measurement and determine the calibration
pulse to use in settings.

2. Tap [Calibration] to display the calibration screen and input the charge to be applied to the object under
measurement in [Charge Value].

3. The calibration pulse is generated from the calibration pulse generator. Tap [Start] to execute calibration.
If calibration fails, increase the charge amount for calibration and execute calibration again.

4. Once calibration is complete, tap [Close] to close the calibration screen and return to the measurement
screen.

5. Output from the calibration pulse generator stops. Disconnect the generator from the object under
measurement.

See: Calibration
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Settings for measurement conditions, judgment conditions, display conditions and storage
conditions

Tap the Settings button to open the setting screen and input the measurement conditions, judgment
conditions, display conditions, and storage conditions.
Once input is complete, tap the Settings button again to close the settings screen and return to the
measurement screen.

Executing Measurement

Check that there are no persons in the vicinity of the object under measurement and press the START key.
High voltage is automatically output from the Hipot tester and AC PD measurement starts. In the case of a
single measurement, when measurement is complete, the Hipot tester output and measurement by the
instrument stops. For repeat measurements (freely running), measurement will continue until the STOP key is
pressed.
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2.9 Loading Measurement Data

Measurement data loading function

This function loads a previously saved data series and displays it on the instrument.

1. When the measurement screen is displayed, tap [Func] at the top-right of the screen.
2. Tap [Load CSV File].

Explorer opens.
3. Select a data series file with the CSV extension. You cannot load a CSV file that is not a data series.

The measurement data is loaded.

If the data is loaded successfully, [Load Success.] is displayed. If you then tap [OK], the measurement
result is displayed on the measurement screen.
If loading the data failed, [Warning No.14 Cannot load this file.] is displayed on the screen.

You cannot use this function while other functions, such as calibration or the band pass filter, are being used.
First close the screen of the function being used, and then use this function.
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2.10 Analysis Functions

Normal mode AC PD analysis functions

With the measurement data displayed on the normal mode AC PD measurement screen,tap [Analysis
Functions] on the right side of the screen to display the following items that can be analyzed. Select an item
to automatically perform the analysis.

Analysis
Item

Description

Qmax-t

Repeatedly occurring maximum PD intensity – Elapsed measurement time
characteristic
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Analysis
Item

Description

Qpk-t

PD charge peak – Elapsed measurement time characteristic

m-t

Number of PD pulses generated – Elapsed measurement time characteristic
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Analysis
Item

Description

Σm-φ

Integrated value characteristic of number of PD pulses generated per phase

q-φ

Apparent charge characteristic per phase
The vertical axis is created with a range of -Sc to +Sc based on the PD axis scale Sc.
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Analysis
Item

Description

Σq-φ

Integrated value characteristic of apparent charge per phase

q-φ-m

Apparent charge – Phase – Number of PD pulses generated characteristic (PRPD
characteristic)
The vertical axis of the PRPD graph (PD charge) is created with a range of -Sc to +Sc
based on the PD axis scale Sc. The resolution of the vertical axis is 1/100th of Sc.
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PDIV mode AC PD analysis functions

With the measurement data displayed on the PDIV mode AC PD measurement screen, tap [Analysis
Functions] on the right side of the screen to display the following items that can be analyzed. Select an item
to automatically perform the analysis.

Analysis
Item

Description

Qmax-t

Repeatedly occurring maximum PD intensity – Elapsed measurement time
characteristic
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Analysis
Item

Description

Qpk-t

PD charge peak – Elapsed measurement time characteristic

m-t

Number of PD pulses generated – Elapsed measurement time characteristic
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Analysis
Item

Description

m-Urms

Number of PD pulses generated – Applied voltage RMS value characteristic

Qpk-Urms

PD charge peak – Applied voltage RMS value characteristic

57HIOKI ST4200B971-00



Common Function

Background Color Change Function

Tap [BG Color] to switch the graph's background color between [White] and [Black].
The selected background color will also apply to other analysis items and be saved in the table settings.

Image Save Function

Tap [Save Image] to save the graph as an image. Set the [Save in] and [Folder Name] from the [Data Save
Settings] screen of [AC PD].
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2.11 Password Function

The password function restricts the functions that can be used and the range of settings that can be
changed.
The passcode can also be set.

Changing the level

1 Tap [Func] > [Password Function] > [Level 0], [Level 1] or [Level 2].

The password function is changed to the specified level.
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If the passcode is set:

2 Enter the passcode on the numeric keypad and tap [OK].

The entered passcode appears as [*] on the screen.
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Setting the passcode

The passcode required when changing the level can be set.

Settable range: 1 to 4 digits
Default passcode: 4200

When the passcode is set, it must be entered when changing the level.
Make sure you do not forget the passcode.

1 Tap [Func] > [Password Function] > [Passcode Setting].
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If the passcode is set:

2 Enter the old passcode on the numeric keypad and tap [OK].

The entered passcode appears as [*] on the screen.

3 Enter the new passcode on the numeric keypad and tap [OK].

The entered passcode appears as [*] on the screen.
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If the passcode is not set:

2 Enter the new passcode on the numeric keypad and tap [OK].

The entered passcode appears as [*] on the screen.

Restrictions by level

There are three levels. Use the appropriate level for the intended usage.

Category Function Level 0 Level 1 Level 2

Measurement mode
Normal mode ✓ ✓ ✓

PDIV mode ✓ ✓ -

Functions Load CSV file ✓ ✓ ✓

Settings

Measurement settings ✓ - -

Judgment settings ✓ - -

Display configuration ✓ - -

Save data settings ✓ - -
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Category Function Level 0 Level 1 Level 2

AC PD measurement

Single/repeat ✓ - -

Calibration ✓ ✓ ✓

Band pass filter ✓ - -

Noise check ✓ - -

Analysis ✓ - -

Zero adjustment ✓ ✓ ✓

Vernier ✓ ✓ ✓

System settings

Table ✓ *1 *2

System ✓ - -

Equipment connection ✓ - -

Self-check ✓ ✓ ✓

Information (update) ✓ - -

✓: Can be used, -: Cannot be used
*1: Only select, save, and load can be used.
*2: Only save can be used.
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3.1 Inspection Before Measurement

DANGER
If the connection cables or the instrument are damaged, there is a risk of an electric shock.
Perform the following inspection before using the instrument:

Preparing for Measurement3

Check that the insulation of the connection cables is neither ripped nor torn and that no metal
parts are exposed.
Replace the connection cords with those specified by Hioki.
Check if there is any damage to the instrument occurred during storage or shipping and verify
that it operates normally before using the instrument.
If you find any damage, contact your authorized Hioki distributor or reseller.
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3.2 Connecting Connection Cables

DANGER
If the insulation on a connecting cable melts, the metal conductor may be exposed. Do not use
any cables whose metal conductor is exposed. Doing so could result in an electric shock, burn,
or other hazards.

WARNING
Use only the connection cables specified by Hioki when using the instrument. Using a non-
specified cable may result in unsafe measurements.
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CAUTION
To prevent cable damage, do not step on cables or pinch them between other objects. Do not
bend or pull on cords at their base.

IMPORTANT

Use only the connection cables specified by Hioki when using the instrument. Using a non-specified
cable may also result in incorrect measurements due to poor connection or other reasons.

The cable is hardened in freezing temperatures. Do not bend or pull it to avoid tearing its shield or
cutting the cable.
Connect the plastic connector (black) or Connection Cable L9218 to the input terminal (green
BNC connector) of the instrument. Connecting a metal connector to an insulated BNC connector
may cause the insulated BNC connector and instrument to be damaged.
When removing a BNC cable, pull it out by holding the head of the BNC connector (other than the
cable) after being sure to disengage the lock to prevent damage to the BNC connector or the
contact.
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Connecting the instrument with the SW2001

Connecting with a LAN Cable

Use a LAN cable to connect the LAN connector (100BASE-TX) on the right side of the instrument to the LAN
connector on the rear of the SW2001.

Connecting with a USB Cable

Use a LAN cable to connect the USB connector on the right side of the instrument to the USB connector on
the rear of the SW2001.

Preparing for AC PD measurement

1 Connect the SW2001 to the instrument.

Connect the AC PD terminal on the right side of the instrument to the AC PD terminal on the
SW2001 using the L9218.
Connect the AC VOLTAGE terminal on the right side of the instrument to the AC VOLTAGE
terminal on the SW2001 using the L9218.
Connect the plastic connector (black) to the ST4200 and the metal connector to the SW2001.
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2 Connect the SW2001 and AC power (insulation/withstand voltage tester).

SW2001 Instruction Manual

IMPORTANT

If using another company’s AC power supply, modify cables to suit the shape of the terminals.

Connect the LOW terminal for the HIPOT TESTER on the rear of the SW2001 to the LOW
OUTPUT terminal on the 3153 using the L2271.
Connect the HIGH terminal for the HIPOT TESTER on the rear of the SW2001 to the LOW
OUTPUT terminal on the 3153 using the L2270.
For further details, see "3.3. Connecting Connection Cables" in the SW2001 instruction manual.
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3 Connect the SW2001 and the object under measurement.

Connect the output terminal on the front of the SW2001 to the measurement points on the object
under measurement using Unterminated Lead Cable L2265.
For further details, see "3.2. Connecting Measurement Cables" in the SW2001 instruction manual.

SW2001 Instruction Manual
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Connecting the instrument with the ST9210

Preparing for AC PD measurement

1 Connect the ST9210 to the instrument.

Connect the AC PD terminal on the right side of the instrument to the AC PD terminal on the
ST9210 using the L9218.
Connect the AC VOLTAGE terminal on the right side of the instrument to the AC VOLTAGE
terminal on the ST9210 using the L9218.
Connect the plastic connector (black) to the ST4200 and the metal connector to the ST9210.
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2 Connect the ST9210 and AC power (insulation/withstand voltage tester).

IMPORTANT

If using another company’s AC power supply, modify cables to suit the shape of the terminals.

3 Connect the ST9210 and the object under measurement.

Connect the output terminal on the front of the ST9210 to the measurement points on the object under
measurement using Unterminated Lead Cable L2265 or L2266.
For further details, see "2.3. Connecting Measurement Cables" in the ST9210 instruction manual.

IMPORTANT

The ST9210 supports only AC PD measurements.

Connect the LOW terminal for the HIPOT TESTER on the rear of the ST9210 to the LOW OUTPUT
terminal on the 3153 using the L2271.
Connect the HIGH terminal for the HIPOT TESTER on the rear of the ST9210 to the LOW
OUTPUT terminal on the 3153 using the L2270.
For further details, see "2.4. Connecting Connection Cables" in the ST9210 instruction manual.
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3.3 Connecting the External Control Terminals

This section describes the procedure and the external control terminal function to control the instrument
externally. Connecting the external control terminals with external devices allows the instrument to start and
stop a measurement. Signals inputted into the external control terminals operate the instrument even when
the key lock function is enabled.
The term “external control terminals” is used to see all of these terminals collectively.

DANGER
To avoid electrical hazards and damage to the instrument, do not apply voltage exceeding the
rated maximum to the external control terminals.

I/O terminals Maximum input voltage

START 10 V DC

STOP 10 V DC

PASS 50 V DC, 50 mA, 200 mW

FAIL 50 V DC, 50 mA, 200 mW

WARNING
Do not use the instrument to measure circuits that exceed those ratings or specifications.
Damage to the instrument or overheating can cause electric shock.

To avoid an electric shock or damage to the equipment, always observe the following
precautions when connecting your external equipment to external control terminals.

Always turn off the instrument and any equipment to be connected before making connections.
Be careful to avoid exceeding the ratings of the external control terminals.
The ground is shared between the instrument and the external control terminals. Isolate the
devices and systems to be connected to the external control terminals from one another, as
needed.
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CAUTION
Only changes described in the instruction manual can be made to Windows settings. Do not
configure any Windows settings that are not instructed in these manuals. In addition, do not
install any software other than the pre-installed software. Doing so will cause instable operation
of the system, with the result that the instrument cannot launch.

Wires to be connected

Item Description

Acceptable wire
Solid wire: 0.32 mm to 0.65 mm in diameter (AWG28 to AWG22)
Stranded wire: 0.08 mm  to 0.32 mm  in diameter (AWG28 to AWG22)
Strand diameter 0.12 mm in diameter or more (per wire)

Stripped length 9 mm to 10 mm

Button pressing tool Flat-blade screwdriver (tip width: 2.6 mm)

Before connecting or disconnecting any cable, always turn off the instrument and your device to
be connected. Failure to do so could result in an equipment malfunction or damage to the
equipment.
To prevent damage to the equipment, use the recommended type of wires to connect your
external equipment to the external control terminals, or otherwise ensure that the wires have
sufficient withstand voltage and current capacity.

2 2
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1 Depress a button of the external control terminals with a flat-blade screwdriver.

2 Insert the wire into the wire connection hole while depressing the button.

3 Release the button.

The wire is secured.

Terminal block

See: Pin Layout of External Control Terminals
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3.4 Connecting the Instrument With Computers

Connecting the instrument with computers via LAN cables allows the computers to control and monitor the
instrument. Connect LAN cables to the instrument LAN connector (100BASE-TX) and computer LAN
connectors.

CAUTION
To avoid damage to the instrument, do not unplug the communication cable during
communication.

The following two ways are available:

(1) Connecting the instrument to the existing network

Ground the ground terminal of the instrument and the ground terminal of the computer to a single
location. Using different ground circuits will result in a ground potential difference between the
instrument and the PC. If a cable is connected while such a potential difference between grounds
exists, it may result in equipment malfunction or failure.
Before connecting or disconnecting a communication cable, always turn off the instrument and
the PC. Failure to do so could result in an equipment malfunction or damage to the equipment.
Securely connect the communication cable connector. Failure to securely connect the connector
could result in a malfunction or damage.
Use a LAN cable with a length of 3 m or less. Using a cable longer than 3 m may cause
malfunctions due to the effects of noise.
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*: Use commercially available 100BASE-TX-compatible or 10BASE-T-compatible LAN cables (either straight
or crossover cables can be used).

(2) One-to-one connection of the instrument and your computer

*: Use commercially available 100BASE-TX-compatible or 10BASE-T-compatible LAN cables (either straight
or crossover cables can be used).

Configuration instructions

1 Set the computer's IP address on the instrument [System Settings] > [Equipment Connection]

screen.

2 Configure the communications settings for the computer based on the settings shown on the

instrument's [System Settings] screen.

Communication between the instrument and computer may not be possible due to noise at the work
site.
This may be due to the communication cable. Change to a CAT7 LAN cable for the LAN cable between
the instrument and LAN hub.
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3.5 Preparing Storage Devices (Recording Media)

You can use the following recording media on the instrument: SD memory cards, USB flash drives, and the
internal drive.
Use only the following Hioki options, which are more reliable than their commercial equivalents.
SD Memory Card Z4001 (2 GB), SD Memory Card Z4003 (8 GB), USB Drive Z4006 (16 GB)

CAUTION
Do not carry the instrument with a USB flash drive inserted. Damage could result.
Do not subject the instrument to extreme shock or vibration. Shock can cause damage to the
SSD unit.
Do not accidentally force storage devices in upside down or backwards. Doing so may damage
the storage device and instrument.

Exercise care when using such products because static electricity could damage the external
storage media or cause a malfunction of the instrument.
Power on the instrument and then insert an SD memory card or a USB flash drive. If the power is
turned on while an SD memory card or USB flash drive is inserted, the instrument may not start
up depending on the SD memory card or USB flash drive.
If an SD memory card or USB flash drive not manufactured by Hioki is used, the instrument may
not recognize the storage device.
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IMPORTANT

See: Options (Sold separately)

Do not extract any external storage device or turn off the instrument while the instrument is accessing
the storage device (while the blue SAVE key is lighting up). Data stored in the device could be lost.
No compensation is available for loss of data stored on any external storage device (USB flash drive, SD
card) or the built-in SSD unit of the instrument, regardless of contents or causes of damage or loss. Be
sure to back up any important data stored on the external storage device (USB flash drive, SD card),
and the built-in SSD unit of the instrument.
When the instrument is left powered off for a long period of time (about one year or more), the data
saved to the built-in SSD may be lost. Be sure to back up the data if the instrument is to be left powered
off for a long time.
Proper operation of the instrument is only guaranteed when using Hioki optional SD Memory Cards and
USB Drives. Proper operation is not guaranteed with other recording media.
With some external storage devices, the instrument may not start up if power is turned on while the
device is inserted. In such a case, turn off and cycle the instrument.
The instrument does not support certain types of USB flash drives, such as those that require fingerprint
authentication or a password.
Number of writes for the external media (USB flash drive, SD memory card) and the built-in SSD unit of
the instrument is limited by their flash memory. If data has been rewritten many times, data reading and
writing capabilities will be degraded. In that case, replace the device. Only use storage devices available
as Hioki options for storing data.
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SD memory card

You have to configure the SD memory card setting on the instrument to use SD memory cards.

How to insert a USB flash drive

1 Orient the face with triangle marked of the SD memory card toward the front of the instrument.

2 Fully insert the SD memory card.
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USB flash drive

You have to configure the USB flash drive setting on the instrument to use USB flash drives.
Before handling a USB flash drive, eliminate any static on your body.

How to insert a USB flash drive

Align the USB flash drive with the connector, and fully insert it.
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Internal drive

The internal drive is factory-formatted.

SSD Unit U8332 (capacity: 256 GB*, option available only when ordered with the instrument)

*: Once the drive has been formatted, the actual capacity available decreases.

You cannot remove the internal drive.
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Removing storage devices

Use the following procedure to remove the SD memory card and USB flash drive.

1 Tap the flash drive eject button at the bottom right of the screen.

2 Tap the media to be removed.

3 Remove the storage device according to the message.

Message Response

This device can now be safely removed from
the ST4200.

Remove the storage device.

This device is currently in use.
Check whether the storage device is being
accessed.

Be sure to use the remove button to remove any storage device. Do not use Windows Explorer or an icon on
the Windows taskbar to remove the storage device.

Formatting storage devices

Format the storage device on the computer.

IMPORTANT

Note that formatting a storage device deletes all the information stored on the storage device, and
deleted information cannot be recovered.
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3.6 How to Open the Media Box

The USB 3.0 connector in the media box is specifically for USB flash drives.
Be sure to use the instrument with the cover closed. Before handling a USB flash drive, eliminate any static
on your body.

1 Extend the handle.

2 Loosen the cover screw until its head is completely removed from the cover.

3 Lift the front of the cover.
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3.7 Supplying Power to the Instrument

WARNING
To prevent electrical shock and to maintain the safety specifications of this instrument, connect
the accompanying power cord only to a 3-prong grounded-type (2-pole) power outlet.

CAUTION
Do not operate the instrument on any of the power sources that provide rectangular-wave or
pseudo-sine-wave power (UPS or uninterruptible power supply, DC/AC inverter). Doing so may
damage the instrument.

IMPORTANT

The instrument can malfunction if the power goes off for over 40 ms.

Turning on the instrument

1 Confirm that the power supply voltage is within the range specified on the left side and connect

the power cord to the power inlet.

Supply power to the instrument in combination with an uninterruptible power supply (UPS) if
instantaneous power interruptions occur frequently. If the power to the ST4200 goes off during
the operation, the built-in system disc will be damaged.
Before connecting the power cable, make sure the supply voltage matches that indicated on its
power connector. Connection to an improper supply voltage may damage the instrument and
present an electrical hazard.
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2 Insert the power cord plug into the outlet.

3 Ground the GND terminal (functional earth terminal) to the earth.

4 Press the power key to turn on the instrument.

Wait around 30 minutes for the instrument's interior temperature to stabilize for an accurate
measurement. (Warming up)

5 Execute zero-adjustment.

See: Executing zero-adjustment

GND terminal (Functional earth terminal)

If you perform measurement in a noisy environment, grounding the GND terminal (functional earth terminal)
allows the instrument to be less susceptible to noise.

Turning off the instrument

IMPORTANT

1 To retain the recorded data, save the data to an external storage device.

2 Press the power key.

Following the message, tap [OK] to turn off the instrument.
When the key lock is engaged, hold down on the power key to turn the power off.
After the instrument has been turned on again, it loads the settings configured before turned off.

If the instrument is shut down while saving files onto an external storage device, it cannot save data
correctly. Supply power to the instrument in combination with an uninterruptible power supply (UPS) if
instantaneous power interruptions occur frequently.
Turning off the instrument causes data recorded in the internal memory to be deleted. To retain the
recorded data, save the data to an external storage device before turning off the instrument.
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3.8 Setting the Clock

Specify the date, time, and time zone. The instrument has an automatic calendar with leap year correction
and 24-hour clock.

How to set the clock

1 Tap [System Settings] > [System].

The [Date and time] dialog box will appear.

2 Set the [Date] and [Time].

3 Tap [Set].

Confirm the date and time.

4 Tap [Normal Mode] or [PDIV Mode].

This returns you to the measurement screen.

IMPORTANT

The instrument regulates the date and time internally. Ensure the date and time are set according to
the method above. If the date and time are set any other way, the settings will not be applied.
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3.9 Executing Zero-Adjustment

Adjust the zero positions of the instrument's input channels to suit the reference potential of the instrument.

Before executing zero-adjustment

To execute zero-adjustment

1 On the measurement screen, tap [Zero Adjust].

The Zero Adjust pop-up window will appear.

2 Tap [Execute].

Zero-adjustment will be performed automatically. Once zero-adjustment is complete, the [Success]
message will be displayed.

3 Tap [Close].

The Zero Adjust pop-up window will close.

Warm up the instrument for about 30 minutes after the power-on to stabilize the internal temperature of the
instrument.
Execute zero-adjustment with no signals inputted.
Zero-adjustment may not correctly be executed with a signal inputted.
Note that you can not execute zero-adjustment during measurement.
No key operation is acceptable during zero-adjustment.
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IMPORTANT

Re-execute zero-adjustment in the following cases:

The zero position may drift.

Drift
A phenomenon where a shift in the operating point of an operational amplifier causes a change in
output. Drift can result from a change in temperature and component aging over a period of use.

After cycling the instrument
After initializing the instrument
When the ambient temperature has significantly changed
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3.10 Configuring the Band Pass Filter (for AC PD
measurement only)

During AC PD measurement, this instrument performs noise processing and signal integration processing on
the PD signal waveforms using a Digital Band Pass Filter (DBPF).
This instrument enables high-accuracy AC PD measurement insusceptible to noise by setting a BPF cutoff
frequency suitable for the noise frequency band in the environment in which the instrument is used.

First measure at the default values (fH = 1000 kHz and fL = 30 kHz). If noise affects the measurement, set the
cutoff frequency with the following procedure.

IMPORTANT

The electric charge calibration value differs depending on the band pass filter settings. When the band
pass filter settings are changed, review the electric charge calibration.

Prepare a calibration pulse generator. We recommend the following calibration pulse generators.

Name of manufacturer Model

Fujikura Dia Cable, Ltd. D-208

Nihon Keisokuki Seizosho Co.,Ltd NPG-3
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1 Confirm that the withstand voltage tester is powered ON and that output is OFF, and confirm

that the cables are connected as shown in the following diagram.

Example of connections when the object under measurement is in a neutral point open state:
Prepare for AC PD measurement.
See: Preparing for AC PD Measurement
(Connect the output terminal and GND terminal of the calibration pulse generator to the part of the object
under measurement that will be measured.)

Connection diagram for the SW2001
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Connection diagram for the ST9210
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In order to take into account the effects of noise generated by the withstand voltage tester’s power
supply and control units, it is recommended that the withstand voltage tester be turned ON.

2 Tap [AC PD] > Setting key > [Operation Settings].

Set Qth to a minimum value of 10 pC.

3 Choose the calibration pulse charge to be used for configuration.

The largest value in the charge range to be measured is recommended.
Using the calibration pulse generator, configure the pulse charge [pC] to be generated.

4 Tap [AC PD] > [Band Pass Filter].

The band pass filter settings screen will be displayed.

5 Turn [BPF Setting Mode] to ON.

If this mode is OFF when measurement is started in step 7, high voltage is generated from the
withstand voltage tester and this may damage the calibration pulse generator.

6 Input the High Cutoff Frequency into [fH] and the Low Cutoff Frequency into [fL].

7 Tap [OK].

The band pass filter setting screen closes.
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8 Measure the Qmax of the noise only.

Leave the calibration pulse generator output OFF.
Press the START key to start a measurement to determine Qmax.

9 Measure the Qmax of calibration pulse.

The calibration pulse generator will generate a calibration pulse.
Press the START key to start a measurement to determine Qmax.

10 Determine the S/N ratio.

The S/N ratio can be determined based on the Qmax values calculated in steps 8 and 9.

11 Repeat steps 3 to 10 as necessary to determine the cutoff frequency.

Find the settings at which the S/N ratio is largest.

The narrower the passband, the lower the PD pulse measurement sensitivity. Choose a cutoff
frequency at which the S/N ratio is large and the passband is as wide as possible.

12 Turn [BPF Setting Mode] to ON.

94HIOKI ST4200B971-00



3.11 Calibration (only for AC PD measurement)

During AC PD measurement, choose a calibration value for converting the PD waveform signal that is input
into a charge.
The calibration values depend on the capacitance of the object under measurement, including connection
cables, clips, etc. The correct values will also depend on the value set for the Band Pass Filter. Therefore,
decide on the routing of the connection cables and connect the object under measurement, configure the
Band Pass Filter, and perform calibration.

CAUTION
Connect the output terminal and GND terminal of the calibration pulse generator to the part of
the object under measurement that will be measured.

1 Confirm that the withstand voltage tester is powered ON and that output is OFF, and confirm

that the cables are connected.

In order to take into account the effects of noise generated by the withstand voltage tester’s power
supply and control units, it is recommended that the withstand voltage tester be turned ON.

2 Choose the calibration pulse charge to be used for configuration.

The largest value in the charge range to be measured is recommended.
Using the calibration pulse generator, configure the pulse charge [pC] to be generated.

3 Tap [AC PD] > [Calibration].

The Calibration screen will be displayed.
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4 Input the charge to be applied to the object under measurement into [Charge Value].

IMPORTANT
The charge value must be the same as the setting value and charge determined in step 2. If
calibration is performed when they are not the same, an incorrect calibration will be performed.

5 The calibration pulse generator will output a calibration pulse.

6 Tap [Start].

The execution screen will be shown and the calibration will be performed automatically. Calibration can
take anywhere from a few seconds to a minute to complete. Wait until the calibration completion
message is displayed.
If the calibration fails, increase the charge to be calibrated and re-calibrate.
Depending on the results of the calibration, the following icons are displayed on the bottom right of the
screen.

Icon Description

Displayed when calibration is not executed.

Displayed when calibration is successful.

Displayed when calibration fails.

7 Stop the calibration pulse generator.
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8 Tap [Close] and detach the calibration pulse generator.

Review the warning message, and then tap [OK]. The calibration screen closes.

CAUTION
Start AC PD measurement after detaching the calibration pulse generator. Failure to do so may
damage the calibration pulse generator.
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3.12 Executing Vernier

Vernier is a function for compensating voltage values during AC PD measurement.
Use after executing AC PD measurement in normal mode.
See: AC PD Measurement in Normal Mode

The vernier correction rate is also used for AC PD measurement in PDIV mode.

Executing vernier

1 Tap [Vernier].

The vernier pop-up window opens.
Input the applied voltage (U) in [Setting Value] and the voltage RMS value (Urms) in [Measurement
Value].

2 Tap [Execute].

The value of [Measurement Value]conforms to that of [Setting value] and the correction ratio is
displayed.
However, [Execute] is disabled if the value of [Measurement Value] is 0 V.

3 Tap [Close].
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Resetting vernier

1 Tap [Vernier].

The vernier pop-up window opens.

2 Tap [Reset].

The values are reset to before compensation.

3 Tap [Close].
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3.13 Configure the Settings for AC PD Measurement in
Normal Mode

Tap the Settings button to open the setting screen.
The Setting screen is separated into the four tabs: [Operation Settings], [Judgment Settings], [Display
Configuration] and [Save Data Settings]. An explanation of the items included under each tab follow.

Operation settings

Symbol
Parameter

name
Content/description Unit Setting range

Default
value

U
Applied
voltage

Voltage applied to the object
under measurement from the
Hipot tester (RMS value)

V

200 to 5000
The starting
voltage differs
depending on the
Hipot tester.

200

Ulimit
Voltage Upper
Limit

The upper limit that can be set
for the applied voltage.

V 200 to 5000 5000
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Symbol
Parameter

name
Content/description Unit Setting range

Default
value

Ilimit
Voltage
Current Limit

The upper limit current value
for the devices controlled.
If a current greater then this
flows, then measurement will
stop.

mA 0.1 to 100.0 0.2

f
Voltage
Frequency

Voltage frequency applied to
the object under measurement
from the Hipot tester

Hz 50.60 50

Tref
Sampling Time
Width

Sampling time width for
primary data when executing
PD calculation

ms 100 to 1000 100

Sc PD Axis Scale
PD axis scale when plotting
realtime waveforms

pC 10 to 5000 300

Qsen
Measurement
Sensitivity

AC PD measurement
sensitivity (gain)
The measurable amount of
discharge is displayed below
the setting value.

-
×1, ×2, ×4, ×10,
×20, ×40

×40

Qth
AC PD
Threshold
Value

Threshold value assuming PD
generation
Pulses below Qth are
considered to be noise.

pC 10 to 5000 10

Er
Qmax
Evaluation
Rate

Set the occurrence frequency
for evaluation of partial
discharge.
This is usually the same as the
test voltage frequency.

pps 1 to 9999 50

fH
High Cutoff
Frequency

Band pass filter high cutoff
frequency

kHz 130 to 1000 1000

fL
Low Cutoff
Frequency

Band pass filter low cutoff
frequency

kHz 30 to 900 30

PD Polarity Reversal Setting

This function sets the PD Polarity Reversal. Tapping [OFF] changes it to [ON], and the polarity of the PD to
be measured will be reversed.
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Judgment settings

Check the check boxes for the measurement items to be judged to enable settings. When multiple items are
selected, overall judging results are shown on the judging results screen.
Judging is available for the following items. The default value for all items is "0".

Symbol Parameter name Unit Setting range

Qmax
Repeatedly occurring maximum PD intensity
(Maximum PD charge exceeding the occurrence frequency set
for the evaluation rate Er)

pC 0 to 5000

m Number of PD pulses exceeding the threshold value pcs 0 to 9999

n ACPD Pulse Repetition Rate pps 0 to 99999

m+ Positive Pole ACPD Pulse Count pcs 0 to 9999

m- Negative Pole ACPD Pulse Count pcs 0 to 9999

P Discharge Power W
-999999 to
999999

D Quadratic Rate C /s 0 to 9999992
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Symbol Parameter name Unit Setting range

I Average Discharge Current A
-999999 to
999999

When the setting value is a positive value, the result is judged as PASS if below the setting value and as FAIL
if above the setting value.
When the setting value is a negative value, the result is judged as PASS if above the setting value and as
FAIL if below the setting value.

Display configuration

Configure the display configuration. The screen is separated into four parts and the following content can be
displayed. However, the same content cannot be displayed more than twice, and all of the content cannot be
set as not to be displayed.
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Display
Contents

Content/description

Judgment
Result

Display the overall judgment result for up to two measurement items.
Results display

---- Not judged.

PASS, FAIL Judgment result

OVER
The measured current is over the measurement range.
Change the Qsen setting and measure again.

Realtime
Value

Results measured within the sampling time are shown in real-time.

Realtime
Waveform

Some of the waveforms measured within the sampling time are shown in real-time.

Settings View Displays the setting items for which measurement was executed.

Data Series
The PD pulse charge measured within the sampling time is shown in a table along
the time at which the PD pulses were generated, the voltage, and phase data.

Judgment Result

The following measurement items can be displayed.

Symbol Parameter name

Qmax
Maximum recurring PD intensity
(Maximum PD charge exceeding the occurrence frequency set for the evaluation rate Er)

m Number of PD Pulses Exceeding The Threshold Value

n PD Pulse Repetition Rate

m+ Positive Pole PD Pulse Count

m- Negative Pole PD Pulse Count

P Discharge Power

D Quadratic Rate

I Average Discharge Current
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Realtime Value

The following measurement items can be displayed.

Symbol Parameter name

Urms Applied Voltage RMS Value

Up+ Positive Voltage Peak Value

Up- Negative Voltage Peak Value

Upp Voltage peak-to-peak (Upp = Up+ - Up-)

Qmax
Repeatedly occurring maximum PD intensity
(Maximum PD charge exceeding the occurrence frequency set for the evaluation rate Er)

m Number of PD Pulses Exceeding The Threshold Value

n PD Pulse Repetition Rate

m+ Positive Pole PD Pulse Count

m- Negative Pole PD Pulse Count

P Discharge Power

D Quadratic Rate

I Average Discharge Current

Settings View

The following setting items can be displayed.

Symbol Parameter name Content/description

U Applied voltage
Voltage applied to the object under measurement from the Hipot
tester (RMS value)

f Voltage Frequency
Voltage frequency applied to the object under measurement from
the Hipot tester

Tref
Sampling Time
Width

Sampling time width for primary data when executing PD
calculation
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Symbol Parameter name Content/description

Qsen
Measurement
Sensitivity

AC PD measurement sensitivity (gain)
The maximum measurable amount of discharge is displayed below
the setting value.

Qth
AC PD Threshold
Value

Threshold value assuming PD generation

Er
Qmax Evaluation
Rate

Set the occurrence frequency for evaluation of partial discharge.
This is usually the same as the test voltage frequency.

fL
Low Cutoff
Frequency

Band pass filter low cutoff frequency

fH
High Cutoff
Frequency

Band pass filter high cutoff frequency

Cr Calibration Rate The Calibration rate for converting the measured AC PD peak value
to charge. Calibration is required prior to measurement.
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Save data settings

Configure the save settings for data series and realtime waveform images. Auto-save and manual save are
possible.

Save Type Content/Description

Auto-save
The instrument automatically saves the acquired data after measurement is
complete.

Manual
save

Press the SAVE key to save.

To save data other than data series, it needs to be displayed on the setting screen. When the data is not
displayed, review the settings in Display Configuration.

Data Series

If the check box is selected, measurement data is included in the contents of the storage file. Some of the
setting values, all measurement results, and each judgment result are saved as CSV files.
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Realtime Waveform Image

If the check box is selected, a screenshot of the realtime waveform image is included in the contents of the
storage file.
Specify the storage file format (BMP, PNG or JPEG) from the [Format] drop-down box.

Saving destination

Specify the storage device (SSD, SD memory card, USB flash drive) to which the files will be saved. When
using multiple USBs, you can select the USB to be used.
When a storage device for saving to is connected to the instrument, a [HIOKI_ST4200] folder is created
automatically. When a save folder is not specified, files are saved in the [AC PD] folder.

Save folder

Specify a folder to save the files to. Create a new folder in [HIOKI_ST4200] and save the file.

File name

Specify a file name for the file to be saved. When specifying [DATA], the name is set automatically according
to the content being saved. For example, the name of the file to which a data series is saved is
[SER_DATA_serial number] and the name of the file to which a realtime waveform image is saved is
[REA_DATA_serial number]. The file name is automatically allocated a serial number.
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3.14 Configure the Settings for AC PD Measurement in
PDIV Mode

Tap the Settings button to open the setting screen.
The Setting screen is separated into the four tabs: [Operation Settings], [Judgment Settings], [Display
Configuration] and [Save Data Settings]. An explanation of the items included under each tab follow.

Operation settings

Symbol
Parameter

name
Content/description Unit Setting range

Default
value

f
Voltage
frequency

Voltage frequency applied to
the object under measurement
from the Hipot tester

Hz 50, 60 50
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Symbol
Parameter

name
Content/description Unit Setting range

Default
value

Us Starting Voltage
Starting voltage for the test in
PDIV mode

%

0 to 100
Cannot be set
for the Hioki
3153. (fixed at
0%)
Kikusui
Electronics
Hipot Tester 1 to
99

10

Umax
Maximum Test
Voltage Value

Maximum test voltage value in
PDIV mode

V

(200 to 5000)
Kikusui
Electronics
Hipot Tester 50
to 5000

1000

Ulimit
Voltage Upper
Limit

The upper limit that can be set
for the applied voltage.

V 200 to 5000 5000

Ilimit
Voltage Current
Limit

The upper limit current value
for the devices controlled.
If a current greater then this
flows, then measurement will
stop.

mA 0.1 to 100.0 0.2

Tref
Sampling Time
Width

Sampling time width for
primary data when executing
PD calculation

ms 100 to 1000 100

Sc PD Axis Scale
PD axis scale when plotting
realtime waveforms

pC 10 to 5000 300

Qsen
Measurement
Sensitivity

AC PD measurement
sensitivity (gain)
The maximum measurable
amount of discharge is
displayed below the setting
value.

-
×1, ×2, ×4, ×10,
×20, ×40

×40

Qth
AC PD
Threshold Value

Threshold value assuming PD
generation
Pulses below Qth are
considered to be noise.

pC 10 to 5000 10
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Symbol
Parameter

name
Content/description Unit Setting range

Default
value

Er
Qmax
Evaluation Rate

Set the occurrence frequency
for evaluation of partial
discharge.
This is usually the same as the
test voltage frequency.

pps 1 to 9999 50

Tru Ramp Up Time
Time from starting voltage to
maximum test voltage value

s 0.1 to 99.9 5.0

Trk
Maximum
Voltage Holding
Time

- s
0.1 to 99.9
The Hioki 3153
is 0.3 to 99.9

1.0

Trd Ramp Down
Time

Time from maximum test
voltage value to 0 V

s 0.1 to 99.9 5.0

fH
High Cutoff
Frequency

Band pass filter high cutoff
frequency

kHz 130 to 1000 1000

fL
Low Cutoff
Frequency

Band pass filter low cutoff
frequency

kHz 30 to 900 30

PD Polarity Reversal Setting

This function sets the PD Polarity Reversal. Tapping [OFF] changes it to [ON], and the polarity of the PD to
be measured will be reversed.
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Judgment settings

Check the check boxes for the measurement items to be judged to enable settings. When multiple items are
selected, overall judging results are shown on the judging results screen.
Judging is available for the following items. The default value for all items is "0".

Symbol Parameter name Unit Setting range

Qmax
Repeatedly occurring maximum PD intensity
(Maximum PD charge exceeding the occurrence frequency set
for the evaluation rate Er)

pC 0 to 5000

m Number of PD pulses exceeding the threshold value pcs 0 to 9999

n ACPD Pulse Repetition Rate PPS 0 to 999999

Ui PD Inception Voltage V 0 to 9999

Ue PD Extinction Voltage V 0 to 9999

m+ Positive Pole ACPD Pulse Count pcs 0 to 9999

m- Negative Pole ACPD Pulse Count pcs 0 to 9999
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Symbol Parameter name Unit Setting range

P Discharge Power W
-999999 to
999999

D Quadratic Rate C /s 0 to 999999

I Average Discharge Current A
-999999 to
999999

FAIL condition

Normally, the judgment is FAIL at the setting value or more and PASS at less than the setting value.
However, for PD inception voltage Ui and extinction voltage Ue, a FAIL judgment can be made at less than
the setting value.

FAIL Condition Description

Over FAIL at the setting value or more and PASS at less than the setting value.

Under PASS at the setting value or more and FAIL at less than the setting value.

PDIV measurement stop function

The PDIV measurement is performed by raising the applied voltage to the maximum voltage and then
lowering the voltage, but the measurement can be stopped with the set condition.

Stop Description

OFF The measurement in progress is not stopped. (Default value)

Ui The measurement is stopped when Ui is recorded while raising the voltage.

Umax The measurement is stopped when the voltage is raised to the maximum voltage.

Ue
The measurement is stopped when Ue is recorded while lowering the voltage.
Even if PD stops occurring once, PD may occur when the measurement is continued. If Ue
is set for the stop condition, the measurement is stopped when PD stops occurring once.

2
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Fail Stop Description

Off The measurement is not stopped even if the judgment is FAIL.

On The measurement is stopped if the judgment is FAIL.

Display configuration

Configure the display configuration. The screen is separated into four parts and the following content can be
displayed. However, the same content cannot be displayed more than twice, and all of the content cannot be
set as not to be displayed.
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Display
Contents

Content/description

Judgment
Result

Display the overall judgment result for up to two measurement items.
Results display

---- Not judged.

PASS, FAIL Judgment result

OVER
The measured current is over the measurement range.
Change the Qsen setting and measure again.

Realtime
Value

Results measured within the sampling time are shown in real-time.

Realtime
Waveform

Some of the waveforms measured within the sampling time are shown in real-time.

Settings View Displays the setting items for which measurement was executed.

Data Series
The PD pulse charge measured within the sampling time is shown in a table along
the time at which the PD pulses were generated, the voltage, and phase data.

Q=f(U) Graph
Measurement results that conform with IEC standards are shown in a two-
dimensional graph.
Voltage is displayed on the X axis and maximum PD charge on the Y axis.

Judgment Result

The following measurement items can be displayed.

Symbol Parameter name

Qmax
Maximum recurring PD intensity
(Maximum PD charge exceeding the occurrence frequency set for the evaluation rate Er)

m Number of PD Pulses Exceeding The Threshold Value

n PD Pulse Repetition Rate

m+ Positive Pole PD Pulse Count

m- Negative Pole PD Pulse Count

P Discharge Power
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Symbol Parameter name

D Quadratic Rate

I Average Discharge Current

Ui PD Inception Voltage

Ue PD Extinction Voltage

Realtime Value

The following measurement items can be displayed.

Symbol Parameter name

Urms Applied Voltage RMS Value

Up+ Positive Voltage Peak Value

Up- Negative Voltage Peak Value

Upp Voltage peak-to-peak (Upp = Up+ - Up-)

m Number of PD Pulses Exceeding The Threshold Value

n PD Pulse Repetition Rate

Qmax
Maximum recurring PD intensity
(Maximum PD charge exceeding the occurrence frequency set for the evaluation rate Er)

P Discharge Power

D Quadratic Rate

I Average Discharge Current

m+ Positive Pole PD Pulse Count

m- Negative Pole PD Pulse Count

Ui PD Inception Voltage

Ue PD Extinction Voltage

Qth AC PD Threshold Value
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Settings View

The following setting items can be displayed.

Symbol Parameter Name Content/Description

f Voltage Frequency
Frequency of the voltage applied to the object under
measurement from the Hipot tester

Tref Sampling Time Width
Sampling time width for primary data when executing PD
calculation

Qsen
Measurement
Sensitivity

AC PD measurement sensitivity (gain)
The maximum measurable amount of discharge is displayed
below the setting value.

Qth
AC PD Threshold
Value

PD Threshold value assuming PD generation

Er
Qmax Evaluation
Rate

Set the occurrence frequency for evaluation of partial discharge.
This is usually the same as the test voltage frequency.

fL
Low Cutoff
Frequency

Band pass filter low cutoff frequency

fH
High Cutoff
Frequency

Band pass filter high cutoff frequency

Us Starting Voltage Starting voltage for the test in PDIV mode

Umax
Maximum Test
Voltage Value

Maximum test voltage value in PDIV mode

Tru Ramp Up Time Time from starting voltage to maximum test voltage value

Trk
Maximum Voltage
Holding Time

-

Trd Ramp Down Time Time from maximum test voltage value to 0 V

Cr Calibration Rate
Calibration Rate for converting the measured AC PD peak value
to charge. Calibration is required prior to measurement.
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Save data settings

Configure the saving settings for data series, real-time waveform images and Q=f(U) graph images. Auto-
save and manual save are possible.

Save Type Content/Description

Auto-save
The instrument automatically saves the acquired data after measurement is
complete.

Manual
save

Press the SAVE key to save.

To save data other than data series, it needs to be displayed on the setting screen. When the data is not
displayed, review the settings in Display Configuration.

Data Series

If the check box is selected, measurement data is included in the contents of the storage file. Some of the
setting values, all measurement results, and each judgment result are saved as CSV files.
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Realtime Waveform Image

If the check box is selected, a screenshot of the realtime waveform image is included in the contents of the
storage file.
Specify the storage file format (BMP, PNG or JPEG) from the [Format] drop-down box.

Q=f(U) Graph

If the check box is selected, a screenshot or the measured values of the Q=f(U) graph are included in the
contents of the storage file.
Specify the storage file format (BMP, PNG, JPEG, or CSV) from the [Format] drop-down box.

Saving destination

Specify the storage device (SSD, SD memory card, USB flash drive) to which the files will be saved. When
using multiple USBs, you can select the USB to be used.
When a storage device for saving to is connected to the instrument, a [HIOKI_ST4200] folder is created
automatically. When a save folder is not specified, files are saved in the [AC PD] folder.

Save folder

Specify a folder to save the files to. Create a new folder in [HIOKI_ST4200] and save the file.

File name

Specify a file name for the file to be saved. When specifying [DATA], the name is set automatically according
to the content being saved. For example, the name of the file to which a data series is saved is
[SER_DATA_serial number], the name of the file to which a real-time waveform image is saved is
[REA_DATA_serial number], and the name of the file to which an Q=f(U) graph image is saved is
[QFU_DATA_serial number]. The file name is automatically allocated a serial number.

119HIOKI ST4200B971-00



Noise level check function

The noise level check function is effective for determining the threshold value Qth for separating noise and
PD.

To detect PD, set the threshold value Qth for separating noise and PD.
In order to do this, you must check the magnitude of the noise.
When you turn ON the noise level check function and take a measurement, the pulse peak value Qpk that
includes noise can be recorded.

The noise level check function takes the measurement using the same settings as a normal measurement, so
configure the settings on the [Operation Settings] screen.

When you start the measurement by pressing the START key, the applied voltage gradually rises from Us (or
0 V) to Umax, and when the measurements are taken up to Umax, the function stops.
The result of the applied voltage and peak value Qpk (includes noise and also PD when PD occurs) can be
checked with the Q=f(U) Graph and Data Series.

When PD occurs, the value of Qpk rapidly increases. Decide on a suitable value for the threshold value to
separate noise and PD from the value of Qpk before and after this rapid increase.

If PD does not occur in the object under measurement or if you do not want to apply much of a load to the
object under measurement, lower the maximum applied voltage Umax, measure just the noise, and then
decide on a value larger than the noise for the threshold value.
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Turn OFF the noise level check function before you set threshold value Qth.
A judgment is not made when taking a measurement during the noise level check.

The noise level check cannot be performed when the BPF setting mode is ON.
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4.1 Overview

The two measurement modes, [Normal Mode] and [PDIV Mode], are available with this instrument.
AC PD measurement can be performed in both these modes.
An overview of each mode follows.

Normal mode

This mode applies constant voltage to measure the magnitude of partial discharge generated.
Generally, AC power is controlled from the instrument, and voltage is automatically applied to the object
under measurement when testing. When using with power controlled from a PC or PLC, or by using manual
control, it is also possible to use only the partial discharge detection function of this instrument.

PDIV mode

This mode automatically increases and decreases the test voltage to find the PD inception voltage
and PD extinction voltage.
The following measurement results can be obtained.

With AC PD measurement:
PD Inception Voltage (Ui)
PD Extinction Voltage (Ue)

Making Measurements4
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4.2 Normal Mode

AC PD measurement

1 Prepare for measurement.

See: Connecting Connection Cables
See: Configuring the Band Pass Filter
See: Calibration
See: Configure the Settings for AC PD Measurement in Normal Mode

DANGER
Before starting measurement, check that no one is touching the connection cables or the object
under measurement, and that the object under measurement and its surroundings are insulated.
Once measurement is started, the AC power supply (insulation/withstand voltage tester) will
automatically output high voltage, which may cause a shock.

123HIOKI ST4200B971-00



2 Navigate to the measurement screen.

Tap [Normal Mode] > [AC PD] to navigate to the measurement screen for normal mode AC DC
measurement.
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3 Select the trigger mode.

Tap to select [Single] or [Repeat].
The instrument operates as follows for each mode.

Trigger
Mode

Trigger Behavior Sampling

Single
Each time the START key is pressed triggers a single
measurement.

Sampling is performed for the
time period specified in [Tref].

Repeat
Measurement is triggered repeatedly from when the
START key is pressed to when the STOP key is
pressed.

-
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4 Perform measurement.

Press the START key.
Voltage will automatically be output to the object under measurement from AC power insulation
withstand voltage tester and AC PD measurement will begin.

IMPORTANT
When the trigger mode is [Single] voltage output also automatically ends once a single
measurement is completed.
When the trigger mode is [Repeat] measurement and voltage output continues until the STOP
key is pressed.
When finished measurement make sure to press the STOP key.

The voltage value can be compensated for using the vernier function.
See: Executing Vernier
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4.3 PDIV Mode

AC PD measurement

1 Prepare for measurement.

See: Connecting Connection Cables
See: Configuring the Band Pass Filter
See: Calibration
See: Configure the Settings for AC PD Measurement in PDIV Mode

DANGER
Before starting measurement, check that no one is touching the connection cables or the object
under measurement, and that the object under measurement and its surroundings are insulated.
Once measurement is started, the AC power supply (insulation/withstand voltage tester) will
automatically output high voltage, which may cause a shock.
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2 Navigate to the measurement screen.

Tap [PDIV Mode] > [AC PD] to navigate to the measurement screen for PDIV mode AC DC
measurement.

3 Perform measurement.

Press the START key.
Voltage will automatically be output to the object under measurement from AC power insulation
withstand voltage tester and AC PD measurement will begin.
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5.1 Table Function

The table function records, and can call up for use, setting values such as calibration values, operation
settings and display settings.
Using the table function makes it possible to switch to different measurement conditions for multiple objects
being tested.

Table function overview

A set of setting values held within the instrument is referred to as a "table".
This instrument references any one of the tables, and this is called the "current table".
Any changes made to setting values through screen operation or communications commands are
immediately applied (saved) to the current table.

A table is different to the concept of a "file" on a computer.
With a computer file, data in the memory at that time is saved using the save operation, but instrument
tables do not have a save operation. Current setting values and values in the current table are
continuously synchronized.
Therefore, to try conditions different than previous measurement conditions while also saving current
measurement conditions, we recommend changing the current table for the instrument to a separate
newly created table before changing the settings.

System Settings5
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Table function setting method

Tap [System Settings] > [Table].

Each Part and Function of the Table Setting Screen

Current Table No., Table Name

The number and name of the current table are displayed.
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Current table setting contents

The typical setting values for the current table are displayed.

List of Tables

This is a list of tables registered in the instrument.
Tap on any of the rows to change the table in that row to the current table.
Tap on any of the rows to highlight the table in that row in white, which allows you to select, delete, initialize,
rename, copy, or paste that table.
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Select

Changes the highlighted table to the current table.
The table number for the selected table is displayed at the bottom right of the screen.

Delete

Deletes the highlighted table.
When the current table is highlighted, the [Delete] button is grayed out and the table cannot be deleted.

Initialization

The highlighted table settings are restored to the default values.

Rename

Renames the highlighted table.
The table name can be up to 40 characters.

Copy

Contents of the highlighted table are copied to the buffer.

Paste

Table content copied to the buffer using [Copy] is pasted to the highlighted table.
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Saving/loading a table

Measurement conditions set in a table can be saved to a file, and measurement conditions saved to a file
can be loaded into a table.

Save

A table can be saved to a file when the SAVE key is pressed while the table screen is displayed.

Save Table Description

Save Current Table
Saves the measurement conditions in the current table to a file.
The file extension is TB1.

Save All Tables
Saves the measurement conditions in all tables to a file.
The file extension is TBL.

Cancel Do not save a table.

Load

Tap [Func] at the top-right of the screen and select [Load Table] to open Explorer. Select a file and load it.

If the file extension is TB1, the measurement conditions saved to the file are loaded into the current table.
To load measurement conditions into a different table, first change the current table.

If the file extension is TBL, the measurement conditions saved to the file are loaded into all tables.
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5.2 System

Items relating to the system of the instrument can be set.
The setting items are as follows.

System protection

Selects the system protection function for when there is a power interruption. The factory default setting is
[ON].
This function uses the UWF (Unified Write Filter) installed in Windows. When operated for more than a month
continuously, we recommend turning this function [OFF] and preparing an external UPS.
When changing settings, the instrument shuts down.

Setting Value Description

ON The system is protected against an unexpected shutdown.

OFF The system is not protected against an unexpected shutdown.
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Beep sound

Select the beep sound operation setting. The factory default setting is [Alert] .

Setting
Value

Description

OFF A beep sound does not sound.

Alert
A beep sound will sound next time.

Alert +
action

In addition to when there is an alert, a beep sound sounds at start, trigger, stop, and
when auto-save is complete.

Language

Select the language to be displayed on the instrument screen.
You can select from the following three languages. The factory default setting is Japanese.

To change the language, first set system protection to [OFF]. When changing settings, the instrument shuts
down.

Shortcut Key

The S1 Key and S2 key on the front of the instrument are assigned shortcuts for migrating to each screen.
The following screens can be selected as shortcut destinations.

When an error message or warning message is displayed
When the judgment is FAIL

Japanese
English
Chinese

Normal Mode - AC PD
PDIV Mode - AC PD
System Settings - Equipment Connection
System Settings - System
System Settings - Table
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Region

Settings for decimal points and separators in data saved to file.
The following settings can be selected. However, the same setting cannot be used for both decimal points
and separators.

Decimal Point

Setting Value Description

Period . A period (.) is used as a decimal point in numerical values.

Comma , A comma (,) is used as a decimal point in numerical values.

Separator

Setting Value Description

Comma , A comma (,) is used as a separator.

Semicolon ; A semicolon (;) is used as a separator.

Space _ A space (_) is used as a separator.

Tab A tab is used as a separator.

Date and time

Set the system date and time for the instrument. Tap on the box and select the date and time then tap on
[Set] to apply the selected date and time.

Initialization

Restores instrument settings to factory settings.
See: List of Initial Settings
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Auto startup

Set the startup method.

Setting
Value

Description

OFF Do not use the automatic startup function.

ON

Use the automatic startup function.
When power is supplied to the instrument, Windows will start automatically and be
ready to take measurements.
The power key on the instrument does not need to be used.
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5.3 Equipment Connection

Configure the communication settings for the instrument and for the measuring instruments and controllers
that link with and control the instrument.

When it is not necessary to link with and control the instrument, set the communication settings for
each measuring instrument to [NONE].
When communication settings are set correctly, AC power and high voltage multiplexer will operate
automatically according to operation commands from the instrument.
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Communication between the instrument and controller

The instrument and controller are connected via LAN. Configure the IP address for the instrument LAN port,
as well as the connecting port.
Configure the LAN settings in accordance with the network connected to the instrument.
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Communication between the instrument and AC power

The instrument and AC power supply equipment are connected via LAN, COM, or VISA. Configure the
communication settings for the instrument according to the communication settings for the AC power supply
equipment.
For equipment that communicates using RS-232C, use a commercially available USB serial conversion cable
to connect with the instrument, and select to use COM.
When communication is not possible, install a USB serial conversion cable driver.
When using a VISA communication interface with the TOS series, a Kikusui Electronics VISA driver is
required. Install a dedicated driver and connect the instrument with the TOS series using a USB cable before
configuring settings.

AC power supply control equipment and the communication interfaces are as follows.

Controller Communication Interface

Automatic Hipot Tester 3153 COM

TOS5200 Series, TOS5300 Series Hipot Testers COM, VISA

TOS9300 Series Hipot Tester LAN, COM, VISA
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Communication between the instrument and high voltage multiplexer

The instrument and high voltage multiplexer are connected via LAN or USB. When connected using USB,
select COM. Configure the communication settings for the instrument according to the communication
settings for the high voltage multiplexer.
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5.4 Information

Displays system information for the instrument.
It is also possible to upgrade the firmware version.
Tap [System Settings] > [Information] to open the Information screen.
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Displayed items

Item Description

Serial No.
The serial number of the instrument.
For the latest information, check Hioki's website.

Software
Version

Indicates the firmware version for the instrument.

FPGA Main
Revision

Indicates the firmware version for the main FPGA.

FPGA Sub
Revision

Indicates the firmware version for the sub FPGA.

Internal drive
Indicates whether the internal drive option was installed when shipped. The drive
installed is displayed. When a drive is not installed, "None" is displayed.

Firmware update

The procedure for firmware updates is as follows.

1 Prepare a USB flash drive.

Use for saving and loading the update file.

2 Download the update file.

The latest version can be downloaded from Hioki’s website.
Hioki Website Software Download Page

143HIOKI ST4200B971-00

https://www.hioki.com/global/support/download/software/


3 Save the update file to the USB flash drive.

Compress the downloaded update file in ZIP format.
Unzip the ZIP file using the Windows Explorer function and save the "update.mrf" file in the root
directory  on the USB flash drive.
*1: Indicates the directory at the highest level of the file hierarchy.

The figure below is an example of saving the file in Windows Explorer in the root directory of the USB
flash drive identified as the F drive.

4 Back up the settings.

The instrument settings may initialize all settings after the update.
Back up the settings as required.
Refer to the update file for the back-up method.

*1
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5 Switch OFF the system protection function.

Tap [System Settings] > [System] and set [System Protection] on the system setting screen to
[OFF]

If [System Protection] is set to [ON] the internal drive cannot be overwritten and the
update is not possible.

6 Insert a USB flash drive into the instrument.

Insert the USB flash drive on which the update file is saved in to the USB connector of the instrument.
The instrument has more than one USB connector. Any can be used.

When updating firmware do not connect a USB device to a USB connector other than
the USB flash drive used for the update.
The update will not be executed properly.
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7 Start the update.

Tap [System Settings] > [Information] and then tap [Update] on the system information screen.
A dialog box will appear confirming that you want to execute the update.Tap [OK] to start the update.
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8 After the power automatically switches off, turn the power ON again.

While the update proceeds, the instrument shuts down after the next screen appears.
With the USB flash drive inserted, turn the power ON.
When the instrument starts up, update processing proceeds automatically.
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9 After the update is finished, turn the power ON again.

When the update is finished, the next screen appears.
Tap on the screen to shut down the instrument.
After shutting down, extract the USB flash drive and turn the power ON.

The update is complete.

When the update does not finish
If the update is still not finished more than 40 minutes after it started, it is likely that the update has failed.
Perform the following steps.

1. If you have a USB keyboard and USB mouse available, connect them to the USB connectors on the
instrument.
Press the Windows key and D key at the same time to display the desktop screen then shut the instrument
down from the start menu.
If you do not have a USB keyboard and USB mouse available, hold down on the instrument power key and
turn the power OFF.

2. Turn ON the power again.
When the update screens are displayed successively, wait until this is finished.
When the measurement screen is displayed, execute the update again.
If any other screen is displayed, contact your authorized Hioki distributor or reseller.
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6.1 Overview

Connecting the external control terminals with external devices allows the instrument to start and stop a
measurement.
This section describes the procedure and the external control terminal function to control the instrument
externally.
The term “external control terminals” is used to see all of these terminals collectively.
Signals inputted into the external control terminals operate the instrument even when the key lock function is
enabled.

For further details on how to connect to external control terminals, refer to "Connecting the External Control
Terminals" in "Preparing for Measurement".
See: Connecting the External Control Terminals

External Control（EXT. I/O）6
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6.2 External Control Functions

Start trigger and stop trigger

External signals can be input to start and stop measurement.

Signal Input Method

Connect the terminal and GND to each other.
See: Connecting the External Control Terminals

Alternatively, input high-level (2.5 V to 10 V) or low-level (0 V to 0.8 V) pulse waves or a rectangular wave to
the terminal.
The electrical characteristics are as follows.

Item Description

Working voltage range High level: 2.5 V to 10 V, Low level: 0 V to 0.8 V

Pulse width High-level period: 50 ms or more

Pulse width 200 ms or more

Maximum input voltage 10 V DC
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Judgment result output

A signal can be output according to the state of the instrument.

Signal Output Method

Connect the PASS terminal or FAIL terminal and the GND terminal to the equipment to be controlled using
the respective cables.
See: Connecting the External Control Terminals

A signal is output according to the state of the instrument. The electrical characteristics are as follows.

Item Description

Output signal Open-drain output (with voltage output) active-low

Output voltage range
High level: 4.0 V\ to 5.0 V
Low level: 0 V\ to 0.5 V

Pulse width 200 ms or more

Maximum input voltage 50 V DC, 50 mA, 200 mW
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7.1 Interface Overview and Features

This instrument is equipped with Ethernet 100BASE-TX as an interface. The instrument can be controlled
from a PC by connecting to a network with a LAN cable supporting 10BASE-T or 100BASE-TX. The
following two connection methods are available:

Communications Function7
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7.2 LAN Settings and Connection

Before command communication using a computer, configure the instrument LAN settings and then connect
the instrument and computer with a LAN cable. Ensure that LAN settings are configured before connecting
to the network. If settings are changed while connected, there is a risk that the IP addresses of other
equipment on the LAN may be duplicated, and that incorrect address information may be sent. For further
details on how to connect the instrument with computers, see Connecting the Instrument With Computers.

IMPORTANT

Do not change any Windows settings that are not instructed in this manual.
Doing so may cause unstable behavior of the system.

Instrument LAN settings

Items to check before configuring settings

Settings will differ when connecting to an existing network and when forming a new network with the
instrument and a single computer.

When connecting the instrument to an existing network

It is necessary to have the network system administrator (department) assign the following items in advance.
Ensure the IP address does not duplicate that of another device.

When forming a new network with the instrument and a single computer

(When using a local network not connected externally) The following addresses are recommended in cases
where there is no administrator or cases where discretion is given for settings.

Computer name and address settings on the instrument
Computer name (up to 15 characters)
IP address
Subnet mask
Gateway (if using)
IP address
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Example setting:

Equipment IP Address Subnet mask Gateway

PC 192.168.0.1 255.255.255.0 OFF

ST4200
First device

192.168.0.2 255.255.255.0 OFF

ST4200
Second device

192.168.0.3 255.255.255.0 OFF

... Append consecutive numbers to the end. 255.255.255.0 OFF

How to configure

[System Settings] > [Equipment Connection]

1 Tap [LAN].

The instrument LAN settings window opens.
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2 Set the required information.

Item Description

IP Address
This is the address for identifying individual devices connected to a
network.
Configure so that it does not duplicate that of another device.

Subnet
mask

This is a setting for separating the IP address into the address part
indicating the network and the address part indicating the device.
Configure so that it is the same subnet mask as other devices on the
same network.

Default
gateway

When connecting to a network
When the computer (device for communication) being used is connected
to a separate network from the network connecting the instrument,
specify the gateway device.
If the computer is on the same network, this is generally set to the same
default gateway as in the computer settings.
When connecting the instrument and computer 1-to-1, or when not
using a gateway
Set the IP address to [0.0.0.0].

Port
Specify the TCP/IP port number to be used for connection for
communication commands.
You can set the port number in the range of 1002 to 49002.

3 Tap [OK].
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7.3 Operating the Instrument With a Browser Installed in
a Computer

You can configure the instrument settings and operate the instrument from a computer with a web browser.
Microsoft Edge is recommended.

Connecting your computer to the instrument with a web browser

When the IP address of the instrument is “192.168.0.3”

With authorization, enter your username and password in the [Username] and [Password] fields on the
main screen to log in.
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Remotely operating the instrument

1 Click [Remote] on the menu.

The screen switches to the remote operation screen, displaying the instrument's screen on the
browser. The operation panel buttons correspond to the buttons on the instrument. Clicking the screen
with a mouse (the same as tapping the screen on the instrument) allows you to operate the instrument
remotely.
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2 Choose a screen update speed from the [Update Speed] drop-down list.

3 To save a screenshot, click [Screen Copy].
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Starting/Stopping measurement

You can start and stop measurement.

1 Click [Start/Stop] on the menu.

The [Measurement Start and Stop] screen appears.
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2 Choose an action.

START Starts a measurement.

STOP Stops the measurement.

No post-measurement processes such as numerical calculations and automatic saving are performed.
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Setting the clock

The time of the clock on your computer can be set by that in the instrument. You cannot set the clock during
measurement.

1 Click [Time Synchronization] on the menu.

The [Synchronization] screen appears, and the time of the clock on the computer and the ST4200
(instrument) appear.
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2 Click [SET].

The time of the clock on the computer is set by that in the ST4200 (instrument). However, an error of
one second may occur.
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7.4 Communication Method

Various messages are provided for controlling the instrument via LAN interface. Messages include program
messages sent from the computer to the instrument, and response messages sent from the instrument to
the PC.

Messages are categorized as follows.

Message format

Program messages

Program messages can be divided into command messages and query messages.

Command messages

Commands for controlling instruments such as for configuring and resetting instruments

Format

[Header part] ␣ [Data part]

Example: Command to set the AC PD applied voltage
:ACPD:VOLTage 1000
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Query messages

Commands for querying operation results, measurement results or the status of instrument settings

Format

[Header part] ?

Example: Command to query the AC PD applied voltage
:ACPD:VOLTage?

Response messages

These are created when a query message is received and the syntax has been checked.
If an error occurs when receiving a query message, no response message will be created for that query
message.

Command syntax

Commands are written in the two following forms.

In this document, the short form portion is written in upper case and the remainder in lower case. Both upper case
and lower case are accepted.

Command text sent to the instrument Content/description

:ACPD:THREsh:VALUe Expression in this document

:ACPD:THRESH:VALUE OK (long form)

:ACPD:THRE:VALU OK (short form)

:ACPD:THRES:VALUE Causes a command error.

:ACPD:THRE:VAL Causes a command error.

Response messages from the instrument are returned in the long form in upper case.

Long form that can be associated with the function
Abbreviated short form
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Header part

Program messages require a header.

Command program header

There are three types as follows.

Command Type Example Description

Simple command-
type header

:PDKInd
Header made up of one word starting with an
alphabetical character

Compound
command header

:ACPD:BPF:UPPEr
A header made up of multiple simple headers
separated by a colon (:)

Simple command-
type header

*RST
A header starting with an (*)indicating that it is a
common command (specified by IEEE 488.2)

Query command headers

This is used to query the status of settings of the instrument. As shown below, a query is recognized when a
question mark (?) is placed after the program header.

Example:
:ACPD:SENSitivity?

Message terminators

The instrument accepts the following as message terminators(delimiter).
LF, CR+LF
The terminator for response messages is fixed as CR+LF.

Separators

Command program header

Multiple messages can be written on a single line by connecting them with a semicolon (;).
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Example:
:ACPD:DATA:VAR? 01;QMAX

When messages are written in succession, if an error occurs midway, the message from there until the
terminator is not executed.

Header separator

For messages with a header and data, the header part and the data part are separated using a space.

Example:
:ACPD:VLIMit 1000

Data separator

In messages containing multiple data items, a comma is required between data items.

Example:
:ACPD:DATA:SERies? 0,2

Data part

The instrument uses "text data" and "base 10 numerical data" in the data part and differentiates these by
command.

Text data

Data that must start with an alphabetical character and is made up of alphabetical and numerical characters.
Text data is accepted in both upper case and lower case, but responses from the instrument are always
returned in upper case. There is a long form and a short form in the same way as command syntax, and both
are accepted.

Example:
:PDMOde NORMal
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Base 10 numerical data

Formats of numerical data include NR1 format, NR2 format and NR3 format. Both signed numerical values
and unsigned numerical values are accepted for each of these. Unsigned numerical values are treated as
positive numerical values. Numerical values after the decimal point that cannot be handled by the instrument
are rounded up to the nearest whole number and input.

The term "NRf format" incorporates all three of the formats above. The instrument accepts NRf format
numerical values.

Response data is sent in the format specified for each command.

Example:
:ACPD:BPF:UPPEr 1000

Output queue and input buffer

Output queue

Response messages are stored in the output queue. The output queue is cleared in the following cases.

The buffer size of the instrument’s output queue is 65536 bytes. When there is no remaining buffer space,
query operations are suspended until a response message is received.

Input buffer

The instrument’s buffer size is 4096 bytes. Messages received are input to this buffer and executed in
sequence. When there is no free buffer space, operations are suspended until the space can be used.

However, they are executed when an :ABORT command is received.

NR1 Integer data (Examples: +12, −23, 34)
NR2 Decimal data (Examples: +1.23, −23.45, 3.456)
NR3 Floating point index representation data (Examples +1.0E-2, −2.3E+4)

When data is read with a controller
When the power is turned on
When a query error occurs
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Status system

The instrument’s status system uses the status model specified by IEEE 488.2 as a reference.

Status Byte Register (STB)

The Status Byte Register (STB) is an 8-bit register that holds information from the event register and output
queue.
The Status Byte Register (STB) is not cleared even when the *STB? query is executed.
It is cleared when the *CLS command is executed, but the ERR bit is not cleared when a instrument anomaly
error occurs.

Each bit of the status byte is a summary (logical sum) of the event registry corresponding to that bit.

Bit number Bit name Description of function

Bit 7 - Not used
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Bit number Bit name Description of function

Bit 6
RQS
MSS

Reserved

Bit 5 ESB
Standard event summary bit
Represents the logical sum of the standard event status register.
Cleared by *ESR?.

Bit 4 MAV
Message available
Set to "1" when there is a message in the output queue.

Bit 3 - Not used

Bit 2 - Not used

Bit 1 - Not used

Bit 0 ESB0
Event Summary Bit 0
This indicates the logical OR of event status register 0.

Use the following command for status byte reading.

Function Command

Status byte reading *STB?

Standard Event Status Register (SESR)

The logical OR of this register is set to bit 5 of the status byte register.
The content of the Standard Event Status Register (SESR) is cleared in the following cases.

1. When the *CLS command is received
2. When the *ESR? query is read
3. When the power is turned on again

Bit
number

Bit
name

Description of function

Bit 7 PON
Power ON flag
When the unit recovers from a power file since this register was last read.
Becomes 1 when the power is turned ON.

Bit 6 URQ Not used

Bit 5 CME
Command error
There is an error with the command received. Syntax error, meaning error
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Bit
number

Bit
name

Description of function

Bit 4 EXE
Execution error
There is an error with the command being executed by the instrument.
Range error, mode error

Bit 3 DDE Not used

Bit 2 QYE
Query error
Queue is empty, data is lost (queue overflow)

Bit 1 RQC Not used

Bit 0 OPC
Operation complete
This is set only when the *OPC command is executed.

The occurring events can be masked by the standard event status enable register (0 when the power is
turned on).
Use the following commands for reading the standard event status register, and configuring and reading the
standard event status enable register.

Function Command

Reading of the Standard Event Status Register *ESR?

Setting of the Standard Event Status Register *ESE

Reading of the Standard Event Status Enable Register *ESE?

Event Status Register 0 (ESR0)

The logical OR of this register is set to bit 0 of the status byte register.
The content of Standard Event Status Register 0 is cleared in the following cases.

1. When the *CLS command is received
2. When the *ESR0? query is read
3. When the power is turned on again

Bit number Description of function

Bit 7 Reserved

Bit 6 The judgment is FAIL

Bit 5 Reserved

Bit 4 Reserved
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Bit number Description of function

Bit 3 Reserved

Bit 2 Waiting for Trigger ends (Set when the triggered is activated)

Bit 1 START Processing ends (Reset when STOP is enabled)

Bit 0 Errors not related to the signal

The occurring events can be masked by the standard event status enable register (0 when the power is
turned on).
Use the following commands for reading the standard event status register, and configuring and reading the
standard event status enable register.

Function Command

Reading of the Event Status Register 0 :ESR0?

Event Status Enable Register 0 settings :ESE0

Reading of the Event Status Enable Register 0 :ESE0?
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7.5 Message Reference

Common commands

Clear status byte register and related queues (except output queue)
*CLS

Syntax

Command
*CLS

Details

The Status Byte Register bits corresponding to the event status registers are also cleared.
The Status Byte Register is also cleared.

Example

*CLS
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Read/Write the Standard Event Status Enable Register (SESER)
*ESE A

Syntax

Command
*ESE A

Query
*ESE?

Response
A<NR1>
A = 0 to 255

Details

Sets the mask pattern for the Standard Event Status Enable Register (SESER).
Returns current Standard Event Status Enable Register (SESER) values.

Example

*ESE 36
*ESE?
(Response)36(When HEADER OFF)
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Read and Clear Standard Event Status Register (SESR)
*ESR?

Syntax

Query
*ESR?

Response
A<NR1>
A = 0 to 255

Details

Returns current Standard Event Status Register (SESR) values and clears the register.

Example

*ESR?
(Response)0(When HEADER OFF)
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Querying device ID (identification code)
*IDN?

Syntax

Query
*IDN?

Response
A$,B$,C$,D$

Details

Queries the device ID.

A$ = Manufacturer name
B$ = Model name
C$ = Serial number
D$ = Software version

Example

*IDN?
(Response)HIOKI,ST4200,123456789,V1.00(When HEADER OFF)

175HIOKI ST4200B971-00



Set the OPC bit of the Standard Event Status Register (SESR) to 1 when
finished all pending operations

*OPC

Syntax

Command
*OPC

Query
*OPC?

Response
A<NR1>

Details

*Sets the Standard Event Status Register (SESR) OPC bit (bit 0) to 1 when all commands prior to the OPC
command have finished processing.
*Responds with 1 when all commands prior to *OPC? have finished.

Example

*OPC
*OPC?
(Response)1(When HEADER OFF)
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Initialize instrument
*RST

Syntax

Command
*RST

Details

Sets the instrument to defaults. However, communication settings and table saved data excluding for the
current table do not change.

Reference: [List of Initial Settings]

Example

*RST
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Read Status Byte Register (STB)
*STB?

Syntax

Query
*STB?

Response
A<NR1>
A = 0 to 255

Details

Returns current Status Byte Register (STB) values.

Example

*STB?
(Response)128(When HEADER OFF)
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Event status register

Read/Write Event Status Enable Register 0 (ESER0)
:ESE0 A

Syntax

Command
:ESE0 A

Query
:ESE0?

Response
A<NR1>
A = 0 to 255

Details

Sets the mask pattern for the Event Status Enable Register 0 (ESER0).
Returns the current Event Status Enable Register 0 (ESER0) values.

Example

:ESE0 64
:ESE0?
(Response)64(When HEADER OFF)
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Read and Clear Event Status Register 0 (ESR0)
:ESR?

Syntax

Query
:ESR?

Response
A<NR1>
A = 0 to 255

Details

Returns current Event Status Register 0 (ESR0) values and clears the register.

Example

:ESR0?
(Response)0(When HEADER OFF)

180HIOKI ST4200B971-00



System command

Set Beep Sound
:SYSTem:BEEPer A$

Syntax

Command
:SYSTem:BEEPer A$

Query
:SYSTem:BEEPer?

Response
A$
A$ = OFF, ON1, ON2

Details

Sets the beep sound.
Returns current beep sound settings.
OFF
ON1 Alert
ON2 Alert + action

Example

:SYSTem:BEEPer ON2
:SYSTem:BEEPer?
(Response)ON2(When HEADER OFF)
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Set and query decimal point
:SYSTem:DECPoint A$

Syntax

Command
:SYSTem:DECPoint A$

Query
:SYSTem:DECPoint?

Response
A$
A$ = DOT, COMMa

Details

Sets the decimal point.
Returns current decimal point settings.
DOT Period
COMMa Comma

Example

:SYSTem:DECPoint DOT
:SYSTem:DECPoint?
(Response)DOT(When HEADER OFF)
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Set and query separators
:SYSTem:SEPArator A$

Syntax

Command
:SYSTem:SEPArator A$

Query
:SYSTem:SEPArator?

Response
A$
A$ = COMMa, SPACe, TAB, SEMI

Details

Sets the separators.
Returns current separator settings.
COMMa Comma
SPACe Space
TAB Tab
SEMI Semicolon

Example

:SYSTem:SEPArator COMMa
:SYSTem:SEPArator?
(Response)COMMA(When HEADER OFF)
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Set and query the date
:SYSTem:DATE A,B,C

Syntax

Command
:SYSTem:DATE A,B,C

Query
:SYSTem:DATE?

Response
A<NR1>,B<NR1>,C<NR1>
A = 2000 to 2080 (year)
B = 1 to 12 (month)
C = 1 to 31 (day)

Details

Sets the date.
Returns the current date.

Example

:SYSTem:DATE 2023,1,2
:SYSTem:DATE?
(Response)2023,1,2(When HEADER OFF)
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Set and query the time
:SYSTem:TIME A,B,C

Syntax

Command
:SYSTem:TIME A,B,C

Query
:SYSTem:TIME?

Response
A<NR1>,B<NR1>,C<NR1>
A = 0 to 23 (hours)
B = 0 to 59 (minutes)
C = 0 to 59 (seconds)

Details

Sets the time.
Returns the current time.

Example

:SYSTem:TIME 12,34,56
:SYSTem:TIME?
(Response)12,34,56(When HEADER OFF)
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Set and query HEADER ON/OFF
:HEADer A$

Syntax

Command
:HEADer A$

Query
:HEADer?

Response
A$
A$ = ON, OFF

Details

Sets whether a query message response header is enabled.
Returns whether a query message response header is currently enabled.

Example

:HEADer ON
:HEADer?
(Response):HEADER ON(When HEADER ON)
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Table operation command

Select table to be used
:TABLe:SELect A

Syntax

Command
:TABLe:SELect A

Query
:TABLe:SELect?

Response
A<NR1>
A = 1 to 50

Details

Selects the table number of the table to be used.
Returns the table number of the currently selected table.

Example

:TABLe:SELect 7
:TABLe:SELect?
(Response)7(When HEADER OFF)
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Initialize table
:TABLe:INITialize

Syntax

Command
:TABLe:INITialize

Details

Initializes all items for Normal mode and PDIV mode for the currently selected table.

Example

:TABLe:INITialize
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Delete table
:TABLe:DELete A

Syntax

Command
:TABLe:DELete A

Details

Deletes the table specified by A.
A<NR1>
A = 1 to 50

Example

:TABLe:DELete 20

Note

A table currently selected cannot be deleted.
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Set and query table name
:TABLe:NAME A,"B$"

Syntax

Command
:TABLe:NAME A,"B$"

Query
:TABLe:NAME? A

Response
B$
B$ = Table name (maximum 40 characters)

Details

Sets table name B to the table specified by A.
Also returns the table name for the table specified by A.
A<NR1>
A = 1 to 50

Example

:TABLe:NAME 7,"Sample name"
:TABLe:NAME? 7
(Response)"Sample name"(When HEADER OFF)
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Copy table
:TABLe:COPY A,B

Syntax

Command
:TABLe:COPY A,B

Details

Copies the table specified by A to the table for B.
A<NR1>,B<NR1>
A = 1 to 50 (copy source)
B = 1 to 50 (copy destination)

Example

:TABLe:COPY 20,30
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Execution control

Start measurement
:STARt

Syntax

Command
:STARt

Details

Starts measurement.

Example

:STARt
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Stop measurement
:STOP

Syntax

Command
:STOP

Details

Stops measurement when calculation is finished.

Example

:STOP

193HIOKI ST4200B971-00



Abort measurement
:ABORt

Syntax

Command
:ABORt

Details

Forcibly ends measurement.
Stops measurement even if calculation is not complete.

Example

:ABORt
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Wait for measurement complete
:FINish?

Syntax

Query
:FINish?

Response
A<NR1>

Details

Returns 1 when measurement is complete.

Example

:FINish?
(Response)1(When HEADER OFF)

Note

With AC PD continuous measurement, a response is not returned until the STOP key is pressed.
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Execute zero adjustment
:UNIT:ADJust

Syntax

Command
:UNIT:ADJust

Details

Executes zero adjustment on all channels and all ranges.
Execution of this command will take time.
To check completion of zero adjustment, wait for a response of 1 to be returned with
“:UNIT:ADJust;*OPC?.”

Example

:UNIT:ADJust
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Types of measurement modes

Set and query measurement mode
:PDMOde A$

Syntax

Command
:PDMOde A$

Query
:PDMOde?

Response
A$
A$ = NORMal, PDIV

Details

Sets the measurement mode.
Returns the current measurement mode.

Example

:PDMOde PDIV
:PDMOde?
(Response)PDIV(When HEADER OFF)
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Set and query type of PD to be measured
:PDKInd A$

Syntax

Command
:PDKInd A$

Query
:PDKInd?

Response
A$
A$ = AC, IMPulse

Details

Sets the type of PD to be measured.
Returns the current type of PD to be measured.

Example

:PDKInd AC
:PDKInd?
(Response)AC(When HEADER OFF)
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AC PD

Operation Settings

Set and query applied voltage (U)
:ACPD:VOLTage A

Syntax

Command
:ACPD:VOLTage A

Query
:ACPD:VOLTage?

Response
A<NR1>
A = 200 to Voltage Upper Limit [V] (3153)
A = 10 to Voltage Upper Limit [V] (TOS5200/TOS530x/TOS930x)

Details

Sets the applied voltage.
Returns the current applied voltage.

Example

:ACPD:VOLTage 1000
:ACPD:VOLTage?
(Response)1000(When HEADER OFF)

199HIOKI ST4200B971-00



Set and query voltage upper limit (Ulimit)
:ACPD:VLIMit A

Syntax

Command
:ACPD:VLIMit A

Query
:ACPD:VLIMit?

Response
A<NR1>
A = 200 to 5000 [V] (3153)
A = 10 to 5000 [V] (TOS5200/TOS530x/TOS930x)

Details

Sets the voltage upper limit.
Returns the current voltage upper limit.

Example

:ACPD:VLIMit 4000
:ACPD:VLIMit?
(Response)4000(When HEADER OFF)
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Set and query the voltage current limit (Ilimit)
:ACPD:ILIMit A

Syntax

Command
:ACPD:ILIMit A

Query
:ACPD:ILIMit?

Response
A<NR2>
A = 0.1 to 100.0 [mA]

Details

Sets the current upper limit.
Returns the current upper limit.

Example

:ACPD:ILIMit 10.5
:ACPD:ILIMit?
(Response)10.5(When HEADER OFF)
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Set and query the voltage frequency (f)
:ACPD:FREQuency A

Syntax

Command
:ACPD:FREQuency A

Query
:ACPD:FREQuency?

Response
A<NR1>
A = 50, 60 [Hz]

Details

Sets the voltage frequency.
Returns the current voltage frequency.

Example

:ACPD:FREQuency 60
:ACPD:FREQuency?
(Response)60(When HEADER OFF)
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Set and query the sampling time width (Tref)
:ACPD:TIME A

Syntax

Command
:ACPD:TIME A

Query
:ACPD:TIME?

Response
A<NR1>
A = 100 to 1000 [ms]

Details

Sets the sampling time width.
Returns the current sampling time width.

Example

:ACPD:TIME 500
:ACPD:TIME?
(Response)500(When HEADER OFF)
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Set and query the PD axis scale (Sc)
:ACPD:SCALe A

Syntax

Command
:ACPD:SCALe A

Query
:ACPD:SCALe?

Response
A<NR1>
A = 10 to 5000 [pC]

Details

Sets the PD axis scale.
Returns the current PD axis scale.

Example

:ACPD:SCALe 100
:ACPD:SCALe?
(Response)100(When HEADER OFF)
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Set and query measurement sensitivity (Qsen)
:ACPD:SENSitivity A

Syntax

Command
:ACPD:SENSitivity A

Query
:ACPD:SENSitivity?

Response
A<NR1>
A = 1, 2, 4, 10, 20, 40 [magnification]

Details

Sets the measurement sensitivity.
Returns the current measurement sensitivity.

Example

:ACPD:SENSitivity 40
:ACPD:SENSitivity?
(Response)40(When HEADER OFF)
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Set and query the AC PD threshold value (Qth)
:ACPD:THREsh:VALUe A

Syntax

Command
:ACPD:THREsh:VALUe A

Query
:ACPD:THREsh:VALUe?

Response
A<NR3>
A = 10.00 to 5000.00 [pC]

Details

Sets the AC PD threshold value.
Returns the current AC PD threshold value.

Example

:ACPD:THREsh:VALUe 5000
:ACPD:THREsh:VALUe?
(Response)005.000E+03(When HEADER OFF)
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Set and query Qmax evaluation rate (Er)
:ACPD:QRATe A

Syntax

Command
:ACPD:QRATe A

Query
:ACPD:QRATe?

Response
A<NR1>
A = 1 to 9999 [pps]

Details

Sets the Qmax evaluation rate.
Returns the current Qmax evaluation rate.

Example

:ACPD:QRATe 60
:ACPD:QRATe?
(Response)60(When HEADER OFF)
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Set and query low cutoff frequency (fL)
:ACPD:BPF:LOWEr A

Syntax

Command
:ACPD:BPF:LOWEr A

Query
:ACPD:BPF:LOWEr?

Response
A<NR1>
A = 30 to 900 [Hz]

Details

Sets the low cutoff frequency.
Returns the current low cutoff frequency.

Example

:ACPD:BPF:LOWEr 100
:ACPD:BPF:LOWEr?
(Response)100(When HEADER OFF)
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Set and query high cutoff frequency (fH)
:ACPD:BPF:UPPEr A

Syntax

Command
:ACPD:BPF:UPPEr A

Query
:ACPD:BPF:UPPEr?

Response
A<NR1>
A = 130 to 1000 [Hz]

Details

Sets the high cutoff frequency.
Returns the current high cutoff frequency.

Example

:ACPD:BPF:UPPEr 900
:ACPD:BPF:UPPEr?
(Response)900(When HEADER OFF)

209HIOKI ST4200B971-00



Set and query the band pass filter setting mode
:ACPD:BPF:MODE

Syntax

Command
:ACPD:BPF:MODE

Query
:ACPD:BPF:MODE?

Response
A$
A$ = OFF, ON

Details

Sets the band pass filter setting mode.
Returns the current band pass filter setting mode.

Example

:ACPD:BPF:MODE ON
:ACPD:BPF:MODE?
(Response)ON(When HEADER OFF)

Note

Do not apply voltage from an AC power supply during measurements when the band pass filter setting
mode is ON.
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Set and query trigger mode (repeat)
:ACPD:REPEat A$

Syntax

Command
:ACPD:REPEat A$

Query
:ACPD:REPEat?

Response
A$
A$ = ON, OFF

Details

Sets the trigger mode (repeat).
Returns the current trigger mode (repeat).
OFF is "Single", ON is "Repeat".

Example

:ACPD:REPEat ON
:ACPD:REPEat?
(Response)ON(When HEADER OFF)
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PDIV Operation Settings

Set and query starting voltage (Us)
:ACPD:VSTArt A

Syntax

Command
:ACPD:VSTArt A

Query
:ACPD:VSTArt?

Response
A<NR1>
A = 1 to 99 [%]

Details

Sets the starting voltage.
Returns the current starting voltage.

Example

:ACPD:VSTArt 50
:ACPD:VSTArt?
(Response)50(When HEADER OFF)

Note

Cannot be set with 3153, TOS5200 and TOS530x.
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Set and query maximum test voltage value (Umax)
:ACPD:RAMP:VOLTage A

Syntax

Command
:ACPD:RAMP:VOLTage A

Query
:ACPD:RAMP:VOLTage?

Response
A<NR1>
A = 200 to Voltage Upper Limit [V] (3153)
A = 10 to Voltage Upper Limit [V] (TOS5200/TOS530x/TOS930x)

Details

Sets the maximum test voltage value.
Returns the current maximum test voltage value.

Example

:ACPD:VSTArt 2000
:ACPD:VSTArt?
(Response)2000(When HEADER OFF)
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Set and query ramp up time (Tru)
:ACPD:RAMP:UP A

Syntax

Command
:ACPD:RAMP:UP A

Query
:ACPD:RAMP:UP?

Response
A<NR2>
A = 0.1 to 99.9 [s]

Details

Sets the ramp up time.
Returns the current ramp up time.

Example

:ACPD:RAMP:UP 20
:ACPD:RAMP:UP?
(Response)20.0(When HEADER OFF)
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Set and query ramp down time (Trd)
:ACPD:RAMP:DOWN A

Syntax

Command
:ACPD:RAMP:DOWN A

Query
:ACPD:RAMP:DOWN?

Response
A<NR2>
A = 0.1 to 99.9 [s]

Details

Sets the ramp down time.
Returns the current ramp down time.

Example

:ACPD:RAMP:DOWN 30
:ACPD:RAMP:DOWN?
(Response)30.0(When HEADER OFF)
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Set and query maximum voltage holding time (Trk)
:ACPD:RAMP:KEEP A

Syntax

Command
:ACPD:RAMP:KEEP A

Query
:ACPD:RAMP:KEEP?

Response
A<NR2>
A = 0.1 to 99.9 [s]

Details

Sets the maximum voltage holding time.
Returns the current maximum voltage holding time.

Example

:ACPD:RAMP:KEEP 40
:ACPD:RAMP:KEEP?
(Response)40.0(When HEADER OFF)
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Set and query PDIV measurement stop condition
:ACPD:PDIV:STOP A$

Syntax

Command
:ACPD:PDIV:STOP A$

Query
:ACPD:PDIV:STOP?

Response
A$
A$ = OFF, UI, UMAX, UE

Details

Sets the condition to stop the PDIV measurement in progress.
OFF:Do not stop measurement in progress
UI:Stop when Ui is recorded while raising the voltage
UMAX:Stop when the voltage is raised to the maximum voltage
UE:Stop when Ue is recorded while lowering the voltage

Example

:ACPD:PDIV:STOP UI
:ACPD:PDIV:STOP?
(Response)UI(When HEADER OFF)
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Set and query stop with FAIL judgment
:ACPD:JUDGe:STOP A$

Syntax

Command
:ACPD:JUDGe:STOP A$

Query
:ACPD:JUDGe:STOP?

Response
A$
A$ = OFF, ON

Details

Sets whether to stop the measurement when a FAIL judgment occurs.
OFF:Do not stop
ON:Stop

Example

:ACPD:JUDGE:STOP ON
:ACPD:JUDGE:STOP?
(Response)ON(When HEADER OFF)
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Set and query FAIL condition during PDIV voltage judgment
:ACPD:JUDGe:VFAil A$

Syntax

Command
:ACPD:JUDGe:VFAil A$

Query
:ACPD:JUDGe:VFAil?

Response
A$
A$ = OVER, UNDer

Details

Sets the FAIL condition in a Ui and Ue judgment.
OVER:FAIL at setting value or more
UNDer:FAIL at less than setting value

Example

:ACPD:JUDGE:VFAIL UNDER
:ACPD:JUDGE:VFAIL?
(Response)UNDER(When HEADER OFF)
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Calibration and Other Commands

Set and query charge value
:ACPD:CAL:CHARge A

Syntax

Command
:ACPD:CAL:CHARge A

Query
:ACPD:CAL:CHARge?

Response
A<NR1>
A = 10 to 5000 [pC]

Details

Sets the charge value.
Returns the current charge value.

Example

:ACPD:CAL:CHARge 5000
:ACPD:CAL:CHARge?
(Response)5000(When HEADER OFF)
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Execute calibration
:ACPD:CAL:EXECute?

Syntax

Query
:ACPD:CAL:EXECute?

Response
A$
A$ = PASS, FAIL

Details

Return the calibration execute result.

Example

:ACPD:CAL:EXECute?
(Response)PASS(When HEADER OFF)
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Set and query calibration rate
:ACPD:CAL:RATE?

Syntax

Query
:ACPD:CAL:RATE?

Response
A<NR3>

Details

Returns the calibration rate.

Example

:ACPD:CAL:RATE?
(Response)100.000E+00(When HEADER OFF)
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Set and query calibration results
:ACPD:CAL:RESult A$

Syntax

Command
:ACPD:CAL:RESult A$

Query
:ACPD:CAL:RESult?

Response
A$
A$ = NONE, PASS, FAIL

Details

Sets the calibration results.
Returns the current calibration results.

Example

:ACPD:CAL:RESult NONE
:ACPD:CAL:RESult?
(Response)NONE(When HEADER OFF)
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Set and query the vernier correction rate
:ACPD:VERNier A

Syntax

Command
:ACPD:VERNier A

Query
:ACPD:VERNier?

Response
A<NR2>

Details

Sets the vernier correction rate.
Returns the current vernier correction rate.

Example

:ACPD:VERNier 1.2
:ACPD:VERNier?
(Response)1.200(When HEADER OFF)
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Set and query judgment function ON/OFF
:ACPD:JUDGe:A$ B$

Syntax

Command
:ACPD:JUDGe:A$ B$

Query
:ACPD:JUDGe:A$?

Response
B$
B$ = ON, OFF

Details

Sets whether a PASS/FAIL judgment is used for measurement parameters specified in the first argument
A.
Specifies ON/OFF in the second argument B.

First argument A$ Parameters for judgment

QMAX Qmax

M m

MP m+

MM m-

N n

P P

D D

I I

PDIV Ui

PDEV Ue

Example

225HIOKI ST4200B971-00



:ACPD:JUDGe:QMAX ON
:ACPD:JUDGe:QMAX?
(Response)ON(When HEADER OFF)
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Set judgment threshold
:ACPD:JLEVel:A$ B

Syntax

Command
:ACPD:JLEVel:A$ B

Query
:ACPD:JLEVel:A$?

Response
B<NR3>

Details

Sets judgment threshold settings for measurement parameters specified in the first argument A$.
Specifies threshold values in the second argument B.

First argument A$ Parameters for setting threshold

QMAX Qmax

M m

MP m+

MM m-

N n

P P

D D

I I

PDIV Ui

PDEV Ue

Example

:ACPD:JLEVel:M 100
:ACPD:JLEVel:M?
(Response)100.000E+00(When HEADER OFF)
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Set and query noise level check function
:ACPD:NOISe A$

Syntax

Command
:ACPD:NOISe A$

Query
:ACPD:NOISe?

Response
A$
A$ = OFF, ON

Details

Sets the noise level check function.

Example

:ACPD:NOISE ON
:ACPD:NOISE?
(Response)ON(When HEADER OFF)

Note

The noise level check function cannot be turned ON when the BPF setting mode is ON.
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Acquiring Measures Results

Acquire the measurement count
:ACPD:DATA:COUNT?

Syntax

Query
:ACPD:DATA:COUNT?

Response
A<NR1>

Details

Acquires the measurement count for current measured data.

Example

:ACPD:DATA:COUNT?
(Response)45(When HEADER OFF)
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Acquire measurement results and judgment results
:ACPD:DATA:VARious? A,B$

Syntax

Query
:ACPD:DATA:VARious? A,B$

Response
See the following explanation.

Details

Specifies the measurement count in the first argument A, and the item in the second argument B$, then
acquires the measured values and judgment results.
The relationship between the second argument B and the response results is shown below.

Measurement item
name

Second
argument B$

Response results C

Date measured DATE
"YYYY/MM/DD HH:MM:SS.SSS"
(Example)"2023/01/23 09:32:02.517"

Test voltage VOLT Returns Urms, Upk+ and Upk- values in
<NR1>, <NR1>, <NR1> (unit: [V]) format.

Voltage frequency FREQ <NR2> (Unit: [Hz])

PD charge and judgment
result

QMAX <NR2>, PASS/FAIL/OVER/NONE (Unit: [pC])

PD threshold value QTH <NR2> (Unit: [pC])

PD charge peak QPK <NR2> (Unit: [pC])

Number of PD and
judgment result

M <NR1>, PASS/FAIL/OVER/NONE (Unit: N/A)

Positive number of PD
and judgment result

MP <NR1>, PASS/FAIL/OVER/NONE (Unit: N/A)

Negative number of PD
and judgment result

MM <NR1>, PASS/FAIL/OVER/NONE (Unit: N/A)

PD occurrence rate and
judgment result

N
<NR1>, PASS/FAIL/OVER/NONE (Unit:
[pps])
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Measurement item
name

Second
argument B$

Response results C

Average discharge
current and judgment
result

I <NR3>, PASS/FAIL/OVER/NONE (Unit: [A])

Discharge power and
judgment result

P <NR3>, PASS/FAIL/OVER/NONE (Unit: [W])

Quadratic rate and
judgment result

D
<NR3>, PASS/FAIL/OVER/NONE (Unit:
[C /s])

Overall judgment result JUDGE PASS/FAIL/OVER/NONE

Example

:ACPD:DATA:VARious? 22,QMAX
(Response)102.46,FAIL(When HEADER OFF)

2
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Acquiring Series Data

Acquire series data
:ACPD:DATA:SERies? A,B

Syntax

Query
:ACPD:DATA:SERies? A,B

Response
C<NR2>,D<NR2>,E<NR1>,F<NR1>
C = Apparent charge time position [s]
D = Apparent charge [pC]
E = Instantaneous voltage [V]
F = Voltage phase [°]

Details

Acquires series data already measured.
Specifies the measurement number (acquires the latest data if 0 is specified) in the first argument A, and
the pulse number in the second argument B.

Example

:ACPD:DATA:SERies? 0,2
(Response)0.00582409, -27.05,251.15(When HEADER OFF)
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Acquiring PDIV Data

Acquire PDIV data
:ACPD:DATA:PDIV?

Syntax

Query
:ACPD:DATA:PDIV?

Response
C<NR1>,D$,E<NR1>,F$,G$

C = PD inception voltage Ui [V]
D$ = PDIV judgment result PASS/FAIL/OVER/NONE
E = PD extinction voltage Ue [V]
F$ = PDEV judgment result PASS/FAIL/OVER/NONE
G$ = Overall judgment result PASS/FAIL/OVER/NONE

Details

Acquires PDIV data already measured and the judgment result.

Example

:ACPD:DATA:PDIV?
(Response)114,PASS,569,FAIL,FAIL(When HEADER OFF)
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Save data settings

Set and query automatic saving for data series
:SAVe:SERies:AUTo A$

Syntax

Command
:SAVe:SERies:AUTo A$

Query
:SAVe:SERies:AUTo?

Response
A$
A$ = OFF, ON

Details

Sets automatic saving for data series.

Example

:SAVE:SERIES:AUTO ON
:SAVE:SERIES:AUTO?
(Response)ON(When HEADER OFF)
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Set and query manual saving for data series
:SAVe:SERies:MANu A$

Syntax

Command
:SAVe:SERies:MANu A$

Query
:SAVe:SERies:MANu?

Response
A$
A$ = OFF, ON

Details

Sets manual saving for data series.

Example

:SAVE:SERIES:MANU ON
:SAVE:SERIES:MANU?
(Response)ON(When HEADER OFF)
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Set and query manual saving for realtime waveform images
:SAVe:WAVe:MANu A$

Syntax

Command
:SAVe:WAVe:MANu A$

Query
:SAVe:WAVe:MANu?

Response
A$
A$ = OFF, ON

Details

Sets manual saving for realtime waveform images.

Example

:SAVE:WAVE:MANU ON
:SAVE:WAVE:MANU?
(Response)ON(When HEADER OFF)
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Set and query format for realtime waveform images
:SAVe:WAVe:FORMat A$

Syntax

Command
:SAVe:WAVe:FORMat A$

Query
:SAVe:WAVe:FORMat?

Response
A$
A$ = BMP, PNG, JPEG

Details

Sets the format for realtime waveform images.

Example

:SAVE:WAVE:FORMAT PNG
:SAVE:WAVE:FORMAT?
(Response)PNG(When HEADER OFF)
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Set and query automatic saving for Q=f(U) graph images
:SAVe:QFU:AUTo A$

Syntax

Command
:SAVe:QFU:AUTo A$

Query
:SAVe:QFU:AUTo?

Response
A$
A$ = OFF, ON

Details

Sets automatic saving for Q=f(U) graph images.

Example

:SAVE:QFU:AUTO ON
:SAVE:QFU:AUTO?
(Response)ON(When HEADER OFF)
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Set and query manual saving for Q=f(U) graph images
:SAVe:QFU:MANu A$

Syntax

Command
:SAVe:QFU:MANu A$

Query
:SAVe:QFU:MANu?

Response
A$
A$ = OFF, ON

Details

Sets manual saving for Q=f(U) graph images.

Example

:SAVE:QFU:MANU ON
:SAVE:QFU:MANU?
(Response)ON(When HEADER OFF)
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Set and query format for Q=f(U) graph
:SAVe:QFU:FORMat A$

Syntax

Command
:SAVe:QFU:FORMat A$

Query
:SAVe:QFU:FORMat?

Response
A$
A$ = BMP, PNG, JPEG, CSV

Details

Sets the format for Q=f(U) graph images.

Example

:SAVE:QFU:FORMAT JPEG
:SAVE:QFU:FORMAT?
(Response)JPEG(When HEADER OFF)
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Set and query automatic saving for SBS graph images
:SAVe:SBS:AUTo A$

Syntax

Command
:SAVe:SBS:AUTo A$

Query
:SAVe:SBS:AUTo?

Response
A$
A$ = OFF, ON

Details

Sets automatic saving for SBS graph images.

Example

:SAVE:SBS:AUTO ON
:SAVE:SBS:AUTO?
(Response)ON(When HEADER OFF)
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Set and query saving destination media
:SAVe:MEDia A$

Syntax

Command
:SAVe:MEDia A$

Query
:SAVe:MEDia?

Response
A$
A$ = SSD, SD, USB1 to USB23

Details

Sets the saving destination media.

Example

:SAVE:MEDIA USB1
:SAVE:MEDIA?
(Response)USB1(When HEADER OFF)
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Set and query the save folder
:SAVe:FOLDer "A$"

Syntax

Command
:SAVe:FOLDer "A$"

Query
:SAVe:FOLDer?

Response
"A$"
A$ = Folder name

Details

Sets the name of the folder to save.

Example

:SAVE:FOLDER "MOTOR"
:SAVE:FOLDER?
(Response)"MOTER"(When HEADER OFF)
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Set and query the save file name
:SAVe:NAME "A$"

Syntax

Command
:SAVe:NAME "A$"

Query
:SAVe:NAME?

Response
"A$"
A$ = File name

Details

Sets the name of the file to save.

Example

:SAVE:NAME "TEST"
:SAVE:NAME?
(Response)"TEST"(When HEADER OFF)
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Commands to control external devices

AC power control
:A command

Syntax

Command
:A command

Query
:A command?

Details

Send and receive commands to the AC power source connected to the ST4200.
Enter commands into command to control the AC power source.
If a command has a ? , it will get a response from the AC source.
Some devices might not use a ? even if they expect a response.
In that case, send :A ? after the initial command to get the answer.

Example

:A *RST (AC power reset)
:A *IDN? (Query about AC power supply identification code)
(Response)HIOKI,3153,0,V2.01
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SW2001 HV Multiplexer control
:R command

Syntax

Command
:R command

Query
:R command?

Details

Send and receive commands to the SW2001 connected to the ST4200.
Enter your commands into command to control the SW2001.
If a command contains a ? , it will retrieve a response from the SW2001.

Example

:R *RST (SW2001 reset)
:R *IDN? (Query about SW2001 identification code)
(Response)HIOKI,SW2001-24,230241007,V1.00
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Other commands

Update screen
:DISPlay:UPDAte

Syntax

Command
:DISPlay:UPDAte

Details

Updates the screen.

Example

:DISPlay:UPDAte
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Set and query the character code used for communication
:INTErface:TXTCode

Syntax

Command
:INTErface:TXTCode

Query
:INTErface:TXTCode?

Response
A$
A$ = character code (AUTO/SJIS/UTF8)

Details

Set the character code use for communication.
Returns the character code used in the current communication.
When set to AUTO, SJIS is used if the ST4200 display language is Japanese, and UTF8 is used if it is
other than Japanese.

Example

:INTErface:TXTCode UTF8
:INTErface:TXTCode?
(Response)UTF8
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8.1 Maintenance and Service

WARNING
Touching any of the high-voltage points inside the instrument is very dangerous.
Do not attempt to modify, disassemble, or repair the instrument. Doing so may cause a fire,
electric shock, or injury.

Backing up the data

The instrument may be initialized (returned to the factory default settings) when it is repaired. Before you ask
for repairs, it is recommended to back up (save or record) the measurement conditions and measured data.

Precautions During Shipment

CAUTION
Be sure to observe the following precautions: *To avoid damage to the instrument, remove any
accessories and optional equipment from the instrument. Use the original packing materials the
instrument was shipped in and be sure to use double packaging. Damage during transportation
is not covered by warranty. *When requesting repairs, be sure to include a memo that describes
the problem in detail.

Replaceable parts and operating lifetimes

The characteristics of some of the parts used in the instrument may deteriorate with extended use.
To ensure the instrument can be used over the long term, it is recommended to replace these parts on a
periodic basis.
When replacing batteries, please contact your authorized Hioki distributor or reseller.
The service life of parts varies with the operating environment and frequency of use. These parts are not
guaranteed to operate throughout the recommended replacement cycle.

Maintenance and Service8
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Part name
Recommended

replacement cycle
Remarks/conditions

Fan motor Approx. 5 years -

LCD
(Backlight)
(Half-life of
brightness)

Approx. 80,000
hours

At an ambient temperature of 25°C
The service life varies significantly depending on the
ambient environment. In particular, the service life reduces
in an environment containing sulfur and halogen, and high
temperature environment.

SSD Unit
U8332

Approx. 1400 hours
(If written to
repeatedly)

At an ambient temperature of 25°C
TBW (Total Byte Written): Approx. 300 TB
Data retention period: About one year (When the instrument
is turned off)
Data backup at regular intervals is recommended.

Electrolytic
capacitors

Approx. 10 years

Printed circuit boards that include this component must be
replaced.
Deteriorates in approx. 10 years when the instrument is
used in a severe environment (at an ambient temperature of
40°C (104°F)).

Lithium
battery

Approx. 10 years

The instrument contains built-in backup lithium batteries,
which offer a service life of about 10 years. If the date and
time deviate substantially at power-on, it is the time to
replace that battery. Contact your authorized Hioki
distributor or reseller.

The fuse is housed in the power unit of the instrument. If the instrument is not powered on, the fuse may be
blown. Customers cannot replace or repair this themselves. Contact your authorized Hioki distributor or
reseller.
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8.2 Self-check

Executing the self-check function checks the instrument for malfunctions.
Tap [System Settings] > [Self-Test].

The self-check consists of the following checks:

Memory check

This function checks the storage memory and backup memory (SRAM memory).

IMPORTANT

1 Tap [Memory check].

Save measurement data in a storage device before performing the memory check. Any measurement
data will be deleted after the memory check.
Do not turn off the instrument during the memory check.
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2 Tap [Execute].

The memory check starts.

To stop the memory check, press the
STOP key to interrupt the memory check. Pressing the operation keys other than the STOP key is
ignored.

The judgment results are displayed once the memory check has been complete.

Results display Result description

PASS The instrument has passed the check.

FAIL The instrument has failed the check. Request repairs.

Abort One of the checks was aborted.

Touch panel check

This check tests the touch panel for proper operation.

1 Tap [Touch panel check].

The sides to be checked go white.

2 Place your finger on a mark  on the edge of a side and drag the side to the other mark  on

the side. When the mark on the other side changes to [✓], release your finger.

The screen displays the judgment result after all of the marks have changed to a check mark.

Results display Result description

PASS The instrument has passed the check.

FAIL The instrument has failed the check. Request repairs.
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Key check

This check tests the keys and rotary knobs for proper operation.

1 Tap [KEY check].

2 Press each operation key one or more times.

The corresponding key is highlighted.

3 Turn the rotary knob clockwise and counterclockwise one or more times each.

Operating all of the keys completes the check.

To cancel the key check:
Tapping [Close] redisplays the previous screen.

LCD check

This check tests the display for proper operation.

1 Tap [LCD check].

The screen becomes uniformly red.

2 Tap the screen or press any key to check the display state.

Every operation changes the screen in the following order, eventually redisplay the original screen.
Red → green → blue → black → white
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LAN check

This check tests the LAN cable for malfunction such as disconnection.

1 Tap [LAN check].

2 Set an IP address used for connecting to the LAN in the [Address] box.

3 Tap [Start].

4 Check the transmission/reception result on the screen.

5 Tap [Close].

Media check

This check tests the storage devices for malfunction.

1 Tap [Media check].

2 Tap the [Media] box and select a storage device from the list.

The screen displays the information of the selected storage device.

3 Tap [Read/Write check].

The read/write check starts.

4 Check the transmission/reception result on the screen.

5 Tap [Close].
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8.3 Cleaning the Instrument

CAUTION

Wipe the LCD gently with a soft, dry cloth.

To clean the instrument, wipe it gently with a soft cloth moistened with water or mild detergent.
Never use solvents such as benzene, alcohol, acetone, ether, ketone, thinners or gasoline. Doing
so could deform and discolor the instrument.
Clean the air vents periodically to avoid blockage. When the vents get clogged, the instrument's
internal cooling effect is hampered, and this can lead to damage to the instrument.
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8.4 Troubleshooting

See "Before Requesting Repairs" if you think there is a problem. If this does not help you resolve your
problem, contact your authorized Hioki distributor or reseller.

Before requesting repairs

If the power or operating keys does not operate properly

Condition Cause Solution Reference

Nothing appears on the
screen even if you turn on
the power.

Connect the
power cord
properly.

Supplying Power
to the Instrument

The instrument does not
operate even if you press
the keys.

Some key is being held
down.

Check if a key is
stuck.

-

The instrument does not
operate even if you press
the keys.

The key lock is engaged.
Disengage the
key lock.

Key lock

The power cord is
disconnected.
The power cord is not
connected properly.
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If the instrument cannot save any data

Condition Cause Solution Reference

The instrument cannot
save any data on a
storage device including
an SD card.

You are not using
Hioki’s optional SD
memory card.

Use Hioki’s optional SD card.
Options (Sold
separately)

The instrument cannot
save any data on a
storage device including
an SD card.

The storage device
does not have
sufficient free space.

Initialize or replace the
storage device.

-

The instrument cannot
save any data on a
storage device including
an SD card.

The storage device
is not properly
inserted.

Properly insert the storage
device.

-

The instrument cannot
save any data on a
storage device including
an SD card.

The storage device
has not been
formatted.

Format the storage device
before initial use.

-

The instrument cannot
save any data on a
storage device including
an SD card.

The number of files
in the folder has
reached 5,000.

Up to 5000 files can be
saved in a folder. If you
would like to create more
files, adjust the quantity.

-

If measurement is not possible

Condition Cause Solution Reference

AC PD measurement
is not possible.

Connect the power
cord properly.

Connecting
Connection
Cables

AC PD measurement
is not possible.

The AC PD sensor (ST9200)
has failed.

Inspect the AC PD
sensor (ST9200).

Inspecting the AC
PD Sensor

It is presumed that normal mode AC PD measurement has been normal so far.
The AC PD sensor or the AC VOLTAGE sensor part of the AC partial discharge sensor (ST9200) may be
malfunctioning.

The measurement cable is
not connected.
The measurement cable is
not connected properly.
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Perform the following inspections.
AC PD sensor inspection:

1 Tap [AC PD] > [Calibration].

The Calibration screen will be displayed.

2 Check [Calibration Rate].

3 Execute calibration again for the same object under measurement.

See: Calibration

4 Check the [Calibration Rate].

Compare the [Calibration Rate] in step 2 with the [Calibration Rate] in step 4.

5 Check that the [Calibration Rate] fluctuation width is 10% or less than the previous time.

If 10% or less, there will be no issues with the AC PD sensor part of the AC PD sensor.
If not, contact your authorized Hioki distributor or reseller.

6 Tap [Close].

Review and address any warning messages, and then tap OK. The calibration screen closes.
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AC VOLTAGE sensor inspection:

1 Tap [AC PD] > Setting key > [Operation Settings].

Set the applied voltage (U) setting to 200 V.

2 Press the START key.

3 Check whether the sine wave for the indicated value of around 200 V is displayed on the real-

time waveform screen of the ST4200 AC PD.

If the sine wave for the indicated value of around 200 V is displayed, there will be no issues with the
AC PD sensor AC VOLTAGE sensor part.
If not, contact your authorized Hioki distributor or reseller.

If the cause cannot be revealed

Initialize the instrument. Settings will be restored to the factory default.
See: Initializing the Instrument
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8.5 Message

If any problem is found, the screen will display an error message or a warning message. It also displays an
informational message with advice for usage.

Action that should be taken after a message

If a message remains

If an error message, warning message, or information message remains, check the details and tap [OK].

To inform of a message with a beep sound

Tap [System Settings] > [System].
See: System

Error messages

The list of error messages is as follows. Check the solution.
If an error is displayed on the screen, the instrument must be repaired. Contact your authorized Hioki
distributor or reseller.

No. Message Solution Reference

176
Internal temperature
is abnormal. Please
turn the power off.

Check the operating temperature environment and fan
rotation before requesting instrument repair.

-
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No. Message Solution Reference

195
Fan malfunction
detected. Power off
immediately.

High internal temperature may damage the instrument.
Immediately turn off the instrument and request
instrument repair.

-

639 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

645 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

646 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

647 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

648 Hardware error A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

649 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

651 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

652 Hardware error
A hardware error was detected. Immediately turn off the
instrument and request instrument repair.

-

653
Processing could
not be successfully
completed.

An error occurred during an internal process of the
instrument. Press the power key and tap [Shutdown] to
turn off the instrument. Then, turn on the instrument
again. You can continue the measurement by tapping
[Continue]; however, you should turn off the instrument
once.

-

Warning messages

The list of warning messages is as follows. Check the solution.

No. Message Solution Reference

10 Please insert media. Insert an SD card or a USB flash drive. -
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No. Message Solution Reference

11

Manual save setting for
Realtime Waveform is not
checked.
Manual save setting for Data
Series is not checked.
Manual save setting for the
Q=f(U) Graph is not checked.
Manual save setting for SBS
Graph is not checked.

On the Save Data Settings screen, check
the box of the item for manual saving.

-

13 Disk full.

The instrument cannot save any files
because of insufficient free space on the
storage device. Delete unnecessary files
to free up enough space or use a new
storage device.

-

14 Cannot load this file.

The selected file cannot be loaded in the
following cases:

-

15 Unable to access file.

Check that the storage device is properly
inserted.
When the storage device is write
protected, cancel write protect.

-

22 No waveform data to save. Perform a measurement. -

23 No data series data to save.
Perform another measurement or load a
file.

-

25
This device cannot be
removed.

The instrument is accessing the device.
Remove the device after the SAVE key
turns off.

Name and
Function of
Each Part

26 Folder is full.
Delete files in the folder or change the
saving destination folder.

-

72 Zero adjustment failed. - -

112 Aborted. - -

209 LAN disconnected. Check the network environment. -

210 LAN timed out. Check the network environment. -

The file is a CSV file to which a
Q=f(U) graph was saved.
The file was saved when the
[Region] settings were different than
the current settings.
The file contents are corrupted.
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No. Message Solution Reference

226 Network error.
A network error occurred during
communication. Check the network
environment.

-

232
File processing could not be
successfully completed.

An unexpected error occurred while a file
is being processed in the SD memory
card or USB flash drive. Replace the
storage device with another or cycle the
instrument.

-

241 File processing error.

An unexpected error occurred while a file
is being processed in the SD memory
card or USB flash drive. Replace the
storage device with another or cycle the
instrument.

-

401

The current exceeds the
measurable range. Please
change the "Qsen" setting so
that it does not exceed the
range.

- -

402

The current exceeds the
measurable range. Please
change the "Range" setting so
that it does not exceed the
range.

- -
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8.6 Initializing the Instrument (System Reset)

Choose settings configured on the instrument to restore them to the factory default settings (basic
measurement settings).

1 Disconnect the measurement sample.

2 Tap [System Settings] > [System].

The System screen is displayed.

3 Tap [Initialize Settings] or [Initialize all].

The instrument will be initialized.

264HIOKI ST4200B971-00



It is also possible to conduct a system reset with the *RST communications command.

List of initial settings

Types of Measurement Modes

Setting item Default setting Initialize Settings Initialize all *RST

Measurement mode Normal ✓ ✓ ✓

Type of PD to be Measured AC ✓ ✓ ✓

AC PD Measurement Operation Settings

Symbol Setting item
Default
setting

Initialize
Settings

Initialize
all

*RST

U Applied voltage 200 V ✓ ✓ ✓

Ulimit Voltage Upper Limit 5000 V ✓ ✓ ✓

Ilimit Voltage Current Limit 0.2 mA ✓ ✓ ✓

f Voltage Frequency 50 Hz ✓ ✓ ✓

Tref Sampling Time Width 100 ms ✓ ✓ ✓

Sc PD Axis Scale 300 pC ✓ ✓ ✓

Qsen Measurement Sensitivity x40 ✓ ✓ ✓

Qth AC PD Threshold Value 10.00 pC ✓ ✓ ✓

Er Qmax Evaluation Rate 50 pps ✓ ✓ ✓

fH High Cutoff Frequency 1000 kHz ✓ ✓ ✓
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Symbol Setting item
Default
setting

Initialize
Settings

Initialize
all

*RST

fL Low Cutoff Frequency 30 kHz ✓ ✓ ✓

Us Starting Voltage 10% ✓ ✓ ✓

Umax Maximum Test Voltage Value 1000 V ✓ ✓ ✓

Tru Ramp Up Time 5.0 s ✓ ✓ ✓

Trk
Maximum Voltage Holding

Time
1.0 s ✓ ✓ ✓

Trd Ramp Down Time 5.0 s ✓ ✓ ✓

- Trigger Mode Single ✓ ✓ ✓

AC PD Measurement Judgment Settings

Symbol Setting item
Default
setting

Default
setting

Initialize
Settings

Initialize
all

*RST

Qmax
Repeatedly occurring

maximum PD
intensity

OFF 0.00 pC ✓ ✓ ✓

m
ACPD Pulse

Repetition Rate
OFF 0 pcs ✓ ✓ ✓

n
ACPD Pulse

Repetition Rate
OFF 0 pps ✓ ✓ ✓

m+
Positive Pole ACPD

Pulse Count
OFF 0 pcs ✓ ✓ ✓

m-
Negative Pole ACPD

Pulse Count
OFF 0 pcs ✓ ✓ ✓

P Discharge Power OFF
0.00000E+00

W
✓ ✓ ✓

D Quadratic Rate OFF
0.00000E+00

C /s
✓ ✓ ✓

I
Average Discharge

Current
OFF

0.00000E+00
A

✓ ✓ ✓

Ui PD Inception Voltage OFF 0 V ✓ ✓ ✓

2
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Symbol Setting item
Default
setting

Default
setting

Initialize
Settings

Initialize
all

*RST

Ue PD Extinction Voltage OFF 0 V ✓ ✓ ✓

Normal Mode AC PD Measurement Display Configuration

Setting item Default setting Initialize Settings Initialize all *RST

Display 1 Judgment Result ✓ ✓ ✓

Display 2 Realtime Value ✓ ✓ ✓

Display 3 Realtime Waveform ✓ ✓ ✓

Display 4 Settings View ✓ ✓ ✓

Judgment Result Item 1 None ✓ ✓ ✓

Judgment Result Item 2 None ✓ ✓ ✓

Realtime Value Item 1 Urms ✓ ✓ ✓

Realtime Value Item 2 Up+ ✓ ✓ ✓

Realtime Value Item 3 Up- ✓ ✓ ✓

Realtime Value Item 4 None ✓ ✓ ✓

Realtime Value Item 5 None ✓ ✓ ✓

Realtime Value Item 6 Qmax ✓ ✓ ✓

Realtime Value Item 7 Qth ✓ ✓ ✓

Realtime Value Item 8 m ✓ ✓ ✓

Realtime Value Item 9 n ✓ ✓ ✓

Realtime Value Item 10 None ✓ ✓ ✓

Settings View Item 1 U ✓ ✓ ✓

Settings View Item 2 f ✓ ✓ ✓

Settings View Item 3 Tref ✓ ✓ ✓

Settings View Item 4 Qsen ✓ ✓ ✓
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Setting item Default setting Initialize Settings Initialize all *RST

Settings View Item 5 Qth ✓ ✓ ✓

Settings View Item 6 fL ✓ ✓ ✓

Settings View Item 7 X ✓ ✓ ✓

Settings View Item 8 Cr ✓ ✓ ✓

Settings View Item 9 None ✓ ✓ ✓

Settings View Item 10 None ✓ ✓ ✓

PDIV Mode AC PD Measurement Display Configuration

Setting item Default setting Initialize Settings Initialize all *RST

Display 1 Judgment Result ✓ ✓ ✓

Display 2 Realtime Value ✓ ✓ ✓

Display 3 Realtime Waveform ✓ ✓ ✓

Display 4 Settings View ✓ ✓ ✓

Judgment Result Item 1 None ✓ ✓ ✓

Judgment Result Item 2 None ✓ ✓ ✓

Realtime Value Item 1 Urms ✓ ✓ ✓

Realtime Value Item 2 Up+ ✓ ✓ ✓

Realtime Value Item 3 Up- ✓ ✓ ✓

Realtime Value Item 4 Ui ✓ ✓ ✓

Realtime Value Item 5 Ue ✓ ✓ ✓

Realtime Value Item 6 Qmax ✓ ✓ ✓

Realtime Value Item 7 Qth ✓ ✓ ✓

Realtime Value Item 8 m ✓ ✓ ✓

Realtime Value Item 9 n ✓ ✓ ✓

Realtime Value Item 10 None ✓ ✓ ✓
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Setting item Default setting Initialize Settings Initialize all *RST

Settings View Item 1 Umax ✓ ✓ ✓

Settings View Item 2 Tru ✓ ✓ ✓

Settings View Item 3 f ✓ ✓ ✓

Settings View Item 4 Tref ✓ ✓ ✓

Settings View Item 5 Qsen ✓ ✓ ✓

Settings View Item 6 Er ✓ ✓ ✓

Settings View Item 7 Qth ✓ ✓ ✓

Settings View Item 8 X ✓ ✓ ✓

Settings View Item 9 Cr ✓ ✓ ✓

Settings View Item 10 None ✓ ✓ ✓

Table

Setting item Initialize Settings Initialize all *RST

Current Table ✓ ✓ ✓

Table Other Than Current Table - Delete -

*1: After Initialize all, the current table becomes No.1.

System

Setting item Default setting Initialize Settings Initialize all *RST

Beep sound Alert - ✓ -

Decimal Point . (period) - ✓ -

Separator , (comma) - ✓ -

Header OFF - ✓ -

*1
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Equipment Connection

Device
Setting

item
Default
setting

Initialize
Settings

Initialize
all

*RST

Controller Port 8802 - ✓ -

AC Power Model 3153 - ✓ -

AC Power Interface NONE - ✓ -

High Voltage
Multiplexer

Interface NONE - ✓ -
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8.7 Disposal (Removing the lithium battery)

The instrument contains a lithium battery for memory backup. When disposing of this instrument, remove the
lithium battery and dispose of the battery and instrument in accordance with local regulations.

WARNING
Do not short-circuit, recharge, disassemble or dispose of them in fire. The battery may explode
if mistreated.

Dispose of the battery in accordance with local regulations.

CALIFORNIA, USA ONLY
Perchlorate Material - special handling may apply.
See https://dtsc.ca.gov/perchlorate/

To avoid an electric shock, turn off the instrument and disconnect any power cords and
connection cables from the instrument before removing the lithium battery.
Keep batteries away from children to prevent accidental swallowing.
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Removing the lithium battery

Required items

Flat-head screwdriver (No.2), Torx screwdriver (T10), hex wrench (2.5), and nippers (one each)

1 Turn off the instrument and remove any cables and storage media.

2 Remove the rear and left panels.

Pushing the left panel downward enables easy removal from the body.

3 Remove the right panel.

Pushing the right panel downward enables easy removal from the body.

4 Remove the handle.

5 Remove the cover of the media box.

6 Remove the upper panel.

7 Use nippers to remove the lithium battery from the printed circuit board.

Pull the lithium battery up from the circuit board, and cut the positive and negative leads with the
nippers.

272HIOKI ST4200B971-00



273HIOKI ST4200B971-00



8.8 Open-source Software

This instrument includes software to which GNU General Public License and other licenses are applied. You
have the right to obtain, modify, and redistribute the source code of the software under these licenses.
For details, visit the following website:
https://www.hioki.com/global/support/oss
Hioki would prefer you not to direct any inquiries on the content of the source code.
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8.9 Rack Mounting

WARNING
Use screws with the specified lengths to prevent damage to the instrument and electric shock.
When you remove the rack mount and restore the instrument to its original condition, use the
screws (M3 × 3 mm) that were installed at the factory.
If you have lost a screw or find that the screw is damaged, contact your authorized Hioki
distributor or reseller.

CAUTION
When mounting the instrument in a rack, place it on the shelf plate and support brackets
specified by the manufacturer of the rack. The rack mount may be damaged if mounted to the
rack with only screws.
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1 Unscrew the screws (M3 × 3 mm) in four locations on the back of the instrument.
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2 Fix the back plate to the instrument with the included screws (M3 × 5 mm) in four locations.
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3 Place the instrument in the rack mounting adapter and fix it with the included screws (M4 × 6

mm) in three locations.

After the instrument is fixed in the adapter
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4 Fix the adapter to the front panel with the included screws (M3 × 8 mm, countersunk head

screw) in six locations.

Completed image
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9.1 General Specifications

Item Description

Operating environment Indoor use, pollution degree 2, altitude up to 2000 m (6562 ft.)

Operating temperature and
humidity range

0°C to 40°C (32°F to 104°F), 80% RH or less (non-condensing)

Storage temperature and
humidity range

-10°C to 50°C (−14°F to 122°F), 80% RH or less (non-
condensing)

Standards

Power supply

Dimensions
Approx. 353W × 235H × 154.8D mm (13.9″W × 9.3″H × 6.1″D)
(excluding protrusions)

Weight
Approx. 7.1 kg (15.7 lbs) (with the U8332 removed)
Approx. 7.3 kg (16.1 lbs) (with the U8332 installed)

Product warranty duration 3 years

Included accessories Included accessories

Options Options

Specifications9

Safety
EN 61010
EMC
EN 61326 Class A

Commercial power
Rated supply voltage: 100 V to 240 V AC
(Assuming voltage fluctuation of ±10%.)
Rated power-supply frequency: 50 Hz/60 Hz
Anticipated transient overvoltage: 2500 V
Maximum rated power: 300 VA
Normal consumption power (reference value): 70 W (AC PD
measurement)
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9.2 Measurement Specifications

Basic specifications

AC PD

Item Description

Measurement
mode

Input channels

Detection
method

Discharge measurement method using detection impedance and band pass
filter based on IEC 60270 and IEC 60034-27-1
See: AC PD Detection Principle

Sampling speed 100 MS/s

Measurement
items

Sampling window
time width (Tref)

100 ms to 1000 ms

Measured value
display update
interval

100 ms to 1000 ms (linked to the value set for the sampling window time width)

Normal Mode
Applies a constant voltage and conducts single or consecutive
measurements
PDIV Mode
Changes applied voltage in conformance with standards while measuring

AC VOLTAGE: Voltage monitor signal (BNC terminal)
AC PD: AC PD current sensor signal (BNC terminal)

Normal Mode
Repeatedly occurring maximum PD intensity (Qmax), number of PD pulses
generated (m, m+, m-), rate of PD pulse generation (n), voltage RMS value
(Urms), voltage peak value (Up+, Up-), voltage peak-to-peak (Upp),
average discharge current (I), discharge power (P), quadratic rate (D), PD
pulse apparent charge (q), PD pulse phase angle (ø)
PDIV Mode
Repeatedly occurring maximum PD intensity (Qmax), number of PD pulses
generated (m, m+, m-), rate of PD pulse generation (n), voltage RMS value
(Urms), voltage peak value (Up+, Up-), voltage peak-to-peak (Upp),
average discharge current (I), discharge power (P), quadratic rate (D), PD
pulse apparent charge (q), PD pulse phase angle (ø), PD inception voltage
(Ui), PD extinction voltage (Ue)
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Item Description

Test frequency
range (applied
voltage)

45 Hz to 1.1 kHz

Frequency
characteristics
(AC PD)

30 kHz to 1 MHz (-6 dB)

Charge
measurable
range

Tested object capacitance C Charge measurable range Q

200 pF ≤ C < 2 nF 10 pC ≤ Q ≤ 500 pC

2 nF ≤ C ≤ 10 nF 10 pC ≤ Q ≤ 2500 pC

PD pulse time
resolution

10 μs
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Accuracy specifications

Item Description

PD pulse phase angle measurement
accuracy (reference value)

Voltage input
frequency

PD pulse phase
angle error (°)

45 Hz ≤ f ≤ 100 Hz ±0.4

100 Hz < f ≤ 400 Hz ±1.0

400 Hz < f ≤ 1 kHz ±2.5

Effect of radiated radio-frequency
electromagnetic field

50 pC or less (at 10 V/m)

Effect of conducted radio-frequency
electromagnetic field

50 pC or less (at 10 V)

Effect of superimposed pulse noise on the
power supply

50 pC or less (with 1 kV and superimposed pulse
noise of pulse width 50 ns)
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Display specifications

Display Equipment

Item Description

Display
12.1-inch XGA TFT color LCD (1024 × 768 dots)
With capacitive touch panel

Graph Displayed Items

Item Description

AC PD

Voltage waveform, PD pulse monitor
X axis: Time
Y axis: Voltage, PD pulse (each on a different scale)
Voltage to discharged quantity characteristics (Q=f(U) Graph)
X axis: Voltage RMS value
Y axis: Maximum PD magnitude occurring repeatedly
Generic graph
X axis: Arbitrary measurement item
Y axis: Arbitrary measurement item
PD pulse phase angle to apparent charge to PD pulse number (PRPD characteristic)
X axis: PD pulse phase angle
Y axis: apparent charge
Z axis (color chart display): PD pulse number or rate of PD pulse generation

284HIOKI ST4200B971-00



9.3 Specifications of Functions

Judgment functions

Item Description

Judgment
description

The judgment is FAIL when the measurement result is equal to or more than
the judgment value and PASS when less than the judgment value.
However, when the judgment value is a negative value, the judgment is FAIL
when the measurement result is equal to or less than the judgment value
and PASS when more than the judgment value.
For PD generation and extinction voltage during a PDIV measurement, a
FAIL judgment at less than the judgment value can be set as the FAIL
condition.

Measurement items
that can be judged

AC PD
Normal mode
Repeatedly occurring maximum PD intensity (Qmax), PD pulse
count (m, m+, m-), PD pulse generation rate (n), Average discharge
current (I), Discharge power (P), Secondary rate (D)
PDIV mode
Repeatedly occurring maximum PD intensity (Qmax), PD pulse
count (m, m+, m-), PD pulse generation rate (n), Average discharge
current (I), Discharge power (P), Secondary rate (D), PD start voltage
(Ui), PD extinction voltage (Ue)

285HIOKI ST4200B971-00



Linked control function

Item Description

High voltage
generator

Partial discharge
detector

Control authority
conflict with host
device

When the ST4200 controls the above devices, the ST4200 has exclusive
control. At other times, the host device can execute command control via
ST4200.

Control description
Linked control of withstand voltage tester as a partial discharge test
high voltage generator
Compatible devices

Hioki
3153 Automatic Insulation/Withstanding HiTester
Kikusui Electronics Corporation
TOS5200 Series, TOS5300 Series, TOS9300 Series
Withstanding Voltage/Insulation Resistance Tester

Control description
Only connect the partial discharge detector to the test circuit during AC
PD testing.
Compatible devices
High Voltage Multiplexer SW2001-04, SW2001-08, SW2001-16,
SW2001-24 (Specification with PD Sensor ST9200 [for AC partial
discharge])
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Save function

Item Description

Saving destination

File system FAT32, NTFS, exFAT

File name Alphanumeric, Japanese, and Chinese input

Handling when a file name same
as an exiting file is specified

A sequence number is added to the end of the file name to
be saved.

Saving type

In normal mode and PDIV mode, select the save type on
each of the Save setting screens for AC PD.
Common save settings

Saving format

File designation
New file or existing file
Before starting a measurement, choose whether a new file is
created or data is appended to the existing file

SAVE key operation
The SAVE key is used to save data based on a pre-defined
destination, file name, and saving setting.

SD Memory Card
Z4001 (2 GB), Z4003 (8 GB)
USB Drive
Z4006 (16 GB)
SSD
U8332 SSD Unit (256 GB)

Automatic saving
The following are automatically saved after
measurements.

Data Series
Q=f(U) graph image

Manual saving
The following are saved by pressing the SAVE key.

Data Series
AC PD Realtime waveform image
Q=f(U) graph image
Graph images of AC PD analysis functions

Tables
.TBL, .TB1
Displayed graph image
.BMP, .PNG, .JPEG
Measurement data
.CSV Saves in the fixed format for each mode
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Data loading function

Item Description

Drive data is loaded from

Loadable data formats
Measurement data (.CSV)
Tables (.TBL, .TB1)

SD Memory Card
Z4001 (2 GB), Z4003 (8 GB)
USB Drive
Z4006 (16 GB)
SSD
U8332 SSD Unit (256 GB)
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Specifications of interfaces

Item Description

USB

RS-232C (USB serial
conversion cable)

No. of Ports
USB 3.0 compatible × 2, USB 2.0 compatible × 4
Connector
Series-A receptacle
Peripheral devices
Keyboard, mouse, USB flash drive, USB serial conversion
cable
Maximum cable length
1 m

Connectible device
Slave measuring instruments of the instrument
Connector
D-sub 9 pins, male
Transmission method
Synchronous step, full duplex
Transmission speed
9600 bps, 19200 bps
Data bit length
8
Stop bits
1
Parity check
None
Delimiter
Transmission: CR+LF, Receiving: LF or CR+LF
Flow control
None
Protocol
Non-procedural
Communication details
Command communication for cooperation control
Default setting
Transmission speed: 9600 bps
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Item Description

LAN

Standards
IEEE802.3
Transmission system
100BASE-TX
Full duplex
Protocol
TCP/IP
Connector
RJ-45
Communication contents
Set and query using communication commands
Settings
IP address, Subnet mask, Default gateway
Port numbers for communication commands: 1002 to 49002
Delimiter
Transmission: CR+LF, Receiving: LF, CR+LF
Maximum cable length
3 m
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Item Description

EXT. I/O

Pin
No.

Signal
name

I/O Description Detection

1 GND - Ground potential -

2 START IN
Measurement
start

Edge

3 STOP IN
Measurement
stop

Edge

4 GND - Ground potential -

5 PASS OUT
Overall
judgement:
PASS

-

6 FAIL OUT
Overall
judgement: FAIL

-

7 GND - Ground potential -

8 N/A - Unassigned -

9 N/A - Unassigned -

10 GND - Ground potential -

Terminal block
Push-button type
Input

Maximum input voltage
10 V DC
Input voltage
High level 2.5 V to 10 V,
Low level 0 V to 0.8 V
Responsible pulse width
High period: 50 ms or more, Low period: 50 ms or more
Pulse intervals
200 ms or more

Output
Output type
Open-drain output(with 5 V output equipped, active-low)
Output voltage
High level: 4.0 V to 5.0 V,
Low level: 0 V to 0.5 V
Maximum input voltage
50 V DC, 50 mA, 200 mW

Pin assignment
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Item Description

Pin
No.

Signal
name

I/O Description Detection

11 GND - Ground potential -
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9.4 Specifications of the Options

U8332 SSD Unit

Item Description

Recording capacity 256 GB (MLC)

Supported interface standard Serial ATA Revision 3.0 compatible (2.5-inch)

Operating temperature and
humidity range

Consistent with the specifications of a PD Detector in which
the U8332 is installed.

Storage temperature and
humidity range

Consistent with the specifications of a PD Detector in which
the U8332 is installed.
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10.1 AC PD Detection Principle

With this instrument, high AC voltage is applied to the insulating part of the object under measurement
(winding wire) in order to detect AC PD. The figure shows an equivalent circuit during AC PD detection.
During AC PD detection, the insulating part is often thought to be pure capacitance .
The figure shows an example of applying high AC voltage to  using high AC voltage and a circuit. If partial
discharge occurs at points where the insulation fails in , the current , discharge flows in the direction of
the arrow shown in the figure. At this time, because the current causing the discharge contains high-
frequency components, the current causing the discharge does not flow to the source of high AC voltage
application serially connected to the blocking coil . The current causing the discharge flows in a circuit
created by the coupling condenser  and detection impedance . Potential difference occurs at both ends
of  according to the current causing the discharge. The instrument records the waveform of this potential
difference and finds the charge quantity  through integration processing.

Detection Principle10

C  a

C  a

C  a I

L

C  k Z

Z

q
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Calculation methods for AC PD measurement items

Calculation methods for AC PD measurement items are based on expressions defined in Section 3.3 of IEC
60270.

This indicates the value obtained by dividing the sum of the absolute value for the magnitude of the
individual apparent charge  during the selected reference time interval  by the derived quantity.
The unit is , i.e., A.

The value of the derived quantity that is the average pulse power fed into the terminals of the object under
measurement due to apparent charge magnitude  during selected reference time interval .
The unit is .

Here, ,   are instantaneous values of the test voltage at the instant of occurrence  of the
individual apparent charge magnitude .

Average Discharge Current I

q  i T  ref

C/s

I =  × (∣q  ∣ + ∣q  ∣ + ⋯ ∣q  ∣)
T  ref

1
1 2 i

Discharge Power P

q  i T  ref

W

P =  × (q  u  + q  u  + ⋯ q  u  )
T  ref

1
1 1 2 2 i i

u  1 u  2 ⋯ u  i q  i

q  i

Quadratic Rate 
This indicates the value obtained by dividing the sum of the squares of individual apparent charge magnitude

 during the selected reference time interval  by the time interval.
The unit is .

D

qi Tref

C /s2

D =  × (q  + q  + ⋯ q  )
T  ref

1
1

2
2

2
i
2
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